Illustrator CC

2014 release

FOR WINDOWS AND MACINTOSH

ELAINE WEINMANN
PETER LOUREKAS
CHAD CHELIUS

Peachpit Press
Acknowledgments

Chad Chelius for jumping in and helping us to fully update and tech edit this edition. We could not have completed this without him!

Nancy Aldrich-Ruenzel has enthusiastically supported our projects since her tenure began as the publisher of Peachpit Press.

Susan Rimerman, our editor, keeps the many wheels in motion for us at Peachpit.

Lisa Brazieal, production editor, did an expert job of preparing our files for printing by RR Donnelley.

Among the other staff members at Peachpit Press who contribute their talents on an ongoing basis are Nancy Davis, editor in chief; Sara Todd, marketing manager; and Alison Serafini, contracts manager.

Elaine Soares, photo research manager, and Lee Scher, photo research coordinator, both of the Image Resource Center at Pearson Education (the parent company of Peachpit Press), quickly procured the stock graphics from Shutterstock.com that we requested.

Chris Lyons, Adobe Illustrator maestro, graciously allowed us to reproduce his artwork on several pages of this book (visit chrislyonsillustration.com).

We package our own books, which means that in addition to writing and testing the text and creating the illustrations, we design and produce press-ready InDesign files. To help us finish this title, Steve Rath generated a comprehensive index, and Scout Festa did a meticulous job of proofreading.

We commend the Illustrator CC prerelease team for producing a great product and for welcoming user input via the beta forum.

Recently, we moved our household and offices from the coast of New England to the mountains of Asheville, North Carolina. We are grateful to our friends and family who have encouraged and supported us in this journey.

Elaine Weinmann and Peter Lourekas
# Contents

## 1 Create & Save Files

- Launching Illustrator .................................. 1
- Creating a new document .............................. 2
- Using templates ...................................... 4
- Adding artboards to a document ★ ................... 7
- Deleting artboards .................................... 9
- Modifying artboards ★ .................................. 10
- Aligning and rearranging artboards .................. 11
- Choosing artboard options ............................ 12
- Saving a document in the Adobe Illustrator (.ai) format ................................................. 13
- Ending a work session ................................ 14

## 2 Manage Color

- Introduction to color management .................... 15
- Choosing color settings for Illustrator ............... 17
- Synchronizing the color settings ................. 20
- Changing the document profile ..................... 21
- Proofing a document onscreen ...................... 22

## 3 Workspaces

- The Hello screen ........................................ 23
- Features of the Illustrator workspace ............... 23
- Using tabbed document windows .................... 25
- Arranging document windows ....................... 26
- Changing the zoom level ......................... 27
- Moving an area of a document into view ............ 28
- Fitting an artboard in the document window ........ 28
- Changing the screen mode ....................... 29
- Switching document views ............................ 30
- Creating custom views ................................ 31
- Configuring the panel groups and docks ............ 32
- Choosing, saving, managing, and resetting workspaces ................................................. 34

## 4 Panels

- The Illustrator panels that are used in this book ... 37
- Creating custom tools panels ★ ...................... 42

## 5 Bridge

- Opening files from Illustrator ......................... 55
- Launching Adobe Bridge ................................ 56
- Features of the Bridge window ....................... 56
- Choosing a workspace for Bridge ★ ............... 58
- Previewing graphics in Bridge ......................... 60
- Opening files from Bridge ★ .......................... 62
- Customizing the Bridge window ..................... 64
- Saving custom workspaces ................................................. 66
- Resetting the Bridge workspace ..................... 66
- Using thumbnail stacks ................................................. 67
- Searching for files ................................................. 68
- Creating and using collections ..................... 69
- Rating and labeling thumbnails .................. 71
- Filtering the display of thumbnails .............. 72
- Choosing a sorting order for thumbnails .......... 72
- Assigning keywords to files ..................... 73
- Exporting the Bridge cache .......................... 74
- Managing files via Bridge .......................... 74

## 6 Geometric Objects

- Selecting and deleting objects .................. 75
- Creating rectangles and ellipses ............... 76
- Reshaping a path using Live Corners and Live Shapes ★ ................................................. 78
- Creating polygons .................................. 80
- Creating stars ....................................... 81
- Creating line segments ............................. 83
- Creating spirals ..................................... 84
- Creating pixel-perfect artwork for the Web ......... 84

## 7 Freehand Drawing

- A quick color primer ..................................... 85
- Drawing with the Pencil tool ★ ...................... 86
- Drawing with the Paintbrush tool ★ ............... 87
- Choosing options for the Pencil and Paintbrush tools ................................................. 88
- Using the Blob Brush tool ★ .......................... 89

## 8 Select

- The five selection tools .................................. 91
- Using the Selection tool ............................ 93
- Using the Direct Selection tool .................... 94
- Selecting objects via a command ................... 94
- Selecting objects via the Layers panel .......... 95
- Working with groups .................................. 96
- Isolating individual objects ....................... 98
- Using the Lasso tool ................................ 98
- Using the Magic Wand tool ....................... 99
- Saving selections .................................. 100
- Selecting and deselecting all objects ............ 100

## 9 Move, Copy & Align

- Moving objects ★ ................................................. 101
- Aligning objects with the help of Smart Guides 102
- Copying objects .................................. 104

In this table of contents and throughout this book, new or improved Illustrator CC features are identified by red stars. ★
### Contents

<table>
<thead>
<tr>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Aligning and distributing objects via buttons</td>
</tr>
<tr>
<td>Creating ruler guides</td>
</tr>
<tr>
<td>Creating guides from objects</td>
</tr>
<tr>
<td>Locking and unlocking guides</td>
</tr>
<tr>
<td>Clearing guides</td>
</tr>
<tr>
<td>Using the grid</td>
</tr>
<tr>
<td><strong>10 Fill &amp; Stroke</strong></td>
</tr>
<tr>
<td>Using color in Illustrator</td>
</tr>
<tr>
<td>Colors for your output medium</td>
</tr>
<tr>
<td>Using the basic color controls</td>
</tr>
<tr>
<td>Saving colors as swatches</td>
</tr>
<tr>
<td>Choosing colors via the Color panel</td>
</tr>
<tr>
<td>Applying colors from a library</td>
</tr>
<tr>
<td>Changing the tint percentage</td>
</tr>
<tr>
<td>Changing the stroke weight, alignment, caps, and joins</td>
</tr>
<tr>
<td>Creating arrows</td>
</tr>
<tr>
<td>Creating a dashed stroke</td>
</tr>
<tr>
<td>Using the Eyedropper tool</td>
</tr>
<tr>
<td>Using the Swatches panel</td>
</tr>
<tr>
<td>Using the Color Guide panel</td>
</tr>
<tr>
<td>Using Kuler</td>
</tr>
<tr>
<td>Replacing colors in your artwork</td>
</tr>
<tr>
<td>Inverting colors</td>
</tr>
<tr>
<td>Colorizing grayscale images</td>
</tr>
<tr>
<td>Blending fill colors</td>
</tr>
<tr>
<td>Creating a pattern</td>
</tr>
<tr>
<td>Editing a pattern</td>
</tr>
<tr>
<td><strong>11 Transform</strong></td>
</tr>
<tr>
<td>Transforming an object via its bounding box</td>
</tr>
<tr>
<td>Using the Free Transform tool</td>
</tr>
<tr>
<td>Using the Scale, Rotate, Shear, and Reflect tools</td>
</tr>
<tr>
<td>Using the Transform and Control panels</td>
</tr>
<tr>
<td>Using the Transform Each command</td>
</tr>
<tr>
<td>Using the Transform effect</td>
</tr>
<tr>
<td>Repeating a transformation</td>
</tr>
<tr>
<td><strong>12 Reshape</strong></td>
</tr>
<tr>
<td>The building blocks of a path</td>
</tr>
<tr>
<td>Moving points and segments</td>
</tr>
<tr>
<td>Reshaping curves</td>
</tr>
<tr>
<td>Converting points</td>
</tr>
<tr>
<td>Adding points</td>
</tr>
<tr>
<td>Deleting points</td>
</tr>
<tr>
<td>Reshaping objects with the Pencil or Paintbrush tool</td>
</tr>
<tr>
<td>Reshaping segments</td>
</tr>
<tr>
<td>Applying a variable width profile preset to an object’s stroke</td>
</tr>
<tr>
<td>Changing an object’s stroke width using the Width tool</td>
</tr>
<tr>
<td>Reshaping objects with the Blob Brush tool</td>
</tr>
<tr>
<td>EXERCISE: Draw and reshape objects in a freehand style</td>
</tr>
<tr>
<td>Using the Reshape tool</td>
</tr>
<tr>
<td>EXERCISE: Create a brush with the Reshape tool</td>
</tr>
<tr>
<td>Erasing sections of objects</td>
</tr>
<tr>
<td>Aligning endpoints</td>
</tr>
<tr>
<td>Reshaping objects using commands</td>
</tr>
<tr>
<td>Slicing and dicing</td>
</tr>
<tr>
<td>EXERCISE: Draw a glass of beer (or cream soda!)</td>
</tr>
<tr>
<td><strong>13 Layers</strong></td>
</tr>
<tr>
<td>Getting to know the Layers panel</td>
</tr>
<tr>
<td>Creating layers</td>
</tr>
<tr>
<td>Deleting layers and objects</td>
</tr>
<tr>
<td>Selecting listings on the Layers panel</td>
</tr>
<tr>
<td>Selecting objects via the Layers panel</td>
</tr>
<tr>
<td>Restacking layers and objects</td>
</tr>
<tr>
<td>Duplicating layers and objects</td>
</tr>
<tr>
<td>Locking layers and objects</td>
</tr>
<tr>
<td>Hiding layers and objects</td>
</tr>
<tr>
<td>Collecting objects into a new layer</td>
</tr>
<tr>
<td>Releasing objects to layers</td>
</tr>
<tr>
<td>Merging layers and groups</td>
</tr>
<tr>
<td>Flattening layers</td>
</tr>
<tr>
<td><strong>14 Appearances</strong></td>
</tr>
<tr>
<td>Applying appearance attributes</td>
</tr>
<tr>
<td>Editing appearance attributes</td>
</tr>
<tr>
<td>Hiding and deleting appearance attributes</td>
</tr>
<tr>
<td>Copying appearance attributes</td>
</tr>
<tr>
<td>Expanding appearance attributes</td>
</tr>
<tr>
<td><strong>15 Effects</strong></td>
</tr>
<tr>
<td>Applying Illustrator effects</td>
</tr>
<tr>
<td>Editing, duplicating, and deleting effects</td>
</tr>
<tr>
<td>A few Illustrator effects up close</td>
</tr>
<tr>
<td>Rasterizing objects</td>
</tr>
<tr>
<td>Applying Photoshop effects via the Effect Gallery</td>
</tr>
<tr>
<td><strong>16 Graphic Styles</strong></td>
</tr>
<tr>
<td>Graphic styles basics</td>
</tr>
<tr>
<td>Loading graphic styles from a library</td>
</tr>
<tr>
<td>Applying graphic styles</td>
</tr>
</tbody>
</table>
Removing a graphic style from an object .......... 223
Applying multiple graphic styles to an object ..... 224
Creating graphic styles ...................... 225
Redefining graphic styles ..................... 226
Deleting graphic styles from the panel .......... 227
Creating a custom graphic styles library ....... 228
Breaking the link to a graphic style .......... 228

17 Image Trace
Tracing a raster image using a preset .......... 229
Applying custom tracing settings .......... 232
Expanding a tracing into paths .......... 237

18 Live Paint
Creating a Live Paint group .............. 240
Using the Live Paint Bucket tool .......... 241
Using the Live Paint Selection tool ........ 244
Reshaping a Live Paint group ........... 246
Adding new faces and edges to a Live Paint group .. 247
Choosing gap options for a Live Paint group .. 248
Expanding and releasing Live Paint groups .. 249

19 Create Type
The type tools ............................ 251
Choosing a font and font size for a type tool ★ ..... 252
Creating point type ........................ 252
Creating area type ★ .................. 253
Creating path type ....................... 256
Copying or moving type characters .......... 258
Importing text into Illustrator ★ ........... 259
Threading type objects ................... 260
Converting point type to area type, and vice versa ... 262
Rotating type ............................ 264
EXERCISE: Putting type on a circle .......... 265

20 Style & Edit Type
Selecting type ............................ 267
Changing the font family and style .......... 269
Working with Typekit fonts ★ ............ 272
Changing the font size .................... 274
Changing the leading value ............... 275
Applying kerning and tracking .......... 276
Using smart punctuation .................. 278
Inserting alternate glyphs ............... 279
Applying hyphenation ..................... 281
Changing paragraph alignment .......... 282
Changing paragraph indentation .......... 283
Changing inter-paragraph spacing .......... 283
Using paragraph and character styles ......... 284
Using the Touch Type tool .......... 287
Hanging punctuation ..................... 288
Setting tabs ......................... 288
Changing the baseline shift value .......... 290
Creating type outlines .................. 291
Wrapping type around an object .......... 292
EXERCISE: Create a shadow for point type .......... 293
Applying appearance attributes to type .... 294
EXERCISE: Add multiple strokes to a character .. 295
EXERCISE: Use the Free Distort effect on type .... 296
Dealing with missing fonts ★ ........... 297
Dealing with missing Typekit fonts ........ 298

21 Pen Tools
Drawing with the Pen tool ★ ............. 299
Converting anchor points on paths ★ ...... 303
EXERCISE: Draw a knife with the Pen tool ...... 305

22 Acquire Images
How images are acquired in Illustrator .......... 307
Using the Open command .................. 308
Using the Place command .................. 309
Importing Photoshop images into Illustrator ...... 312
Managing linked images ................... 314
Embedding and unembedding images .......... 317
Dragging and dropping images into Illustrator .... 318

23 Brushes
Applying brushes to existing paths .......... 320
Using the Brushes panel .................. 321
Removing brush strokes from objects .......... 322
Expanding brush strokes .................. 323
Creating and editing Calligraphic brushes ...... 324
Creating and editing Scatter brushes .......... 326
Creating and editing Art brushes ............ 328
Creating and editing Bristle brushes .......... 331
Creating and editing Pattern brushes .......... 334
Painting brush strokes inside objects .......... 338
Duplicating brushes ..................... 339
Editing a brush manually .................. 340
Editing brush strokes on objects .......... 341
Deleting brushes ....................... 342
Creating a custom brush library .......... 342

24 Gradients
Applying a gradient to an object’s fill or stroke .... 343
Creating a two-color gradient ................ 344
Editing gradient colors via on-object controls ★ .... 349
Saving a gradient as a swatch .......... 350
Changing the position, length, or angle of a gradient in an object ................. 351
Spreading a single gradient across multiple objects ....................... 353
Expanding a gradient into paths ........................................ 354

25 Combine paths
Using the Shape Builder tool ...................................... 355
Applying the Shape Mode commands ................................ 359
Applying the Pathfinder commands .................................. 362
Using the Compound Path command ................................ 365
Working with compound paths ...................................... 366
Applying Pathfinder effects ........................................... 368

26 Clipping Masks
Creating a clipping set ................................................. 369
Selecting objects in a clipping set ..................................... 373
Adding objects to, and deleting them from, a clipping set .......... 375
Releasing a clipping set .................................................. 376

27 Transparency
Changing an object’s opacity or blending mode ....................... 377
Controlling which objects the transparency settings affect .......... 380
Creating an opacity mask .............................................. 382
Editing masked artwork or the masking object in an opacity mask . 383

28 Symbols
Accessing the symbol libraries ........................................ 386
Creating individual symbol instances ................................ 387
Creating symbol sets with the Symbol Sprayer tool ................ 388
Replacing symbols in a document ..................................... 389
Creating symbols .......................................................... 390
Deleting symbols from the panel ...................................... 390
Creating a custom symbol library .................................... 391
Editing symbols ............................................................ 391
Choosing options for the symbolism tools .......................... 392
Using the Symbol Shifter, Scruncher, Sizer, Spinner, Stainer, Screener, and Styler tools ........................................ 393
Unlinking symbol instances ............................................ 397
Expanding symbol instances .......................................... 398

29 Live Color
Creating color groups via the Recolor Artwork dialog ............... 399
Using the color wheel in the Recolor Artwork dialog ................ 401
Assigning colors to artwork via the Recolor Artwork dialog ....... 403
Reducing colors via the Recolor Artwork dialog ..................... 405

30 Preferences
Opening the Preferences dialog ...................................... 407
General Preferences ....................................................... 408
Sync Settings Preferences .............................................. 410
Selection & Anchor Display Preferences ............................ 411
Type Preferences .......................................................... 412
Units Preferences .......................................................... 413
Guides & Grid Preferences ............................................. 414
Smart Guides Preferences .............................................. 415
Slices Preferences .......................................................... 416
Hyphenation Preferences ............................................... 416
Plug-ins & Scratch Disks Preferences ................................ 417
User Interface Preferences ............................................. 418
File Handling & Clipboard Preferences .............................. 419
Appearance of Black Preferences ..................................... 420

31 Print & Export
Print dialog: General options ........................................ 422
Marks and Bleed options ............................................... 424
Output options ................................................................ 426
Graphics options .......................................................... 428
Color Management options ............................................ 430
Advanced options ......................................................... 431
Summary options .......................................................... 431
Using the Separations Preview panel ................................ 432
Printing and exporting semitransparent objects ..................... 434
Creating and editing presets ............................................ 437
Producing crop and trim marks ......................................... 438
Choosing a resolution for effects ..................................... 439
Packaging files for output ............................................... 440
Choosing a file format for export ..................................... 442
Saving files in the Adobe PDF format ................................. 442
Using the Export command ............................................ 446
Using the Document Info panel ....................................... 447
Optimizing files for the Web ............................................ 448
Exporting artwork as CSS code ....................................... 452
Exporting Illustrator files to Adobe Photoshop .................... 454

Appendix
Syncing Illustrator settings via Creative Cloud ....................... 455
Importing and exporting Illustrator settings ......................... 456
Sharing your artwork on Behance ...................................... 458

Index .............................................................................. 459
REGISTER THIS BOOK, THEN DOWNLOAD GRAPHICS FOR FREE!

Purchasing this book entitles you to more than just a couple of pounds of paper. If you register the book with Peachpit Press, you will also be entitled to download copies of many of the graphics that are used throughout the book, which you can use to practice with as you follow our step-by-step tutorials.

To access the bonus graphics, log into your Peachpit account or create one at Peachpit.com/join (it’s free). On your Account page (under the Registered Products tab), click Register Your Products Here or Register Another Product, enter the ISBN number for this book: 0133987035, then click Submit. Finally, below the title of this book, click the Access Bonus Content link.

Note: The downloadable graphics that we have made available are copyrighted by their owners, and they have been watermarked to discourage unauthorized reproduction. They are for your personal use only — not for distribution or publication.

NOTE TO OUR READERS

Before going to press with this book, we tested (and retested) our text to ensure that it accurately describes the options and features we viewed in the prerelease version of Illustrator CC (2014 release). Due to the nature of the Creative Cloud, however, some features may change or update at a later date.

If there are any significant changes to Illustrator, we will post an addendum in the Access Bonus Content link below this book title at Peachpit.com, so be sure to register the book (see the directions above). Also, we may post supplemental information about Illustrator on our blog at elaineandpeter.com.
This chapter will help you become more intimately acquainted with the Illustrator interface features that you will be using continually as you work: the panels. In the preceding chapter, you learned how to arrange them onscreen. Here you will see what the individual panels look like and be briefly introduced to their specific functions—from choosing color swatches (Swatches panel) to switching among artboards (Artboards panel) to editing layers (Layers panel). Note: In-depth instructions for using specific panels are amply provided throughout this book.

The Illustrator panels that are used in this book*

You can read through this chapter with or without glancing at or fiddling with the panels onscreen, and also use it as a reference guide as you work. Panel icons are shown on the next page. Following that, you’ll find instructions for using the Tools panel, a brief description of each tool, an introduction to the Control panel, then a description and illustration of all the other Illustrator panels that are used in this book (in alphabetical order). Note: To open a panel that isn’t already in a dock, choose the panel name from the Window menu.

**CHOOSING VALUES IN A PANEL OR DIALOG**

To change a value incrementally, click in a field in a panel or dialog, then press the up or down arrow key on the keyboard.

Click the up or down arrow to change the value incrementally. Or choose a preset value from the menu. Or enter a new value in the field.

**SHORTCUTS FOR ENTERING VALUES IN ILLUSTRATOR PANELS**

<table>
<thead>
<tr>
<th>Apply a value and highlight the next field</th>
<th>Tab</th>
</tr>
</thead>
<tbody>
<tr>
<td>Apply a value and highlight the previous field</td>
<td>Shift-Tab</td>
</tr>
<tr>
<td>Apply a value and exit the panel</td>
<td>Return/Enter</td>
</tr>
</tbody>
</table>

*The Actions, SVG Interactivity, and Variables panels aren’t covered in this book.*
Identifying the panel icons

Each panel in Illustrator has a unique icon. If you keep the panels collapsed to conserve screen space, you can identify them by their icons. If you don’t recognize a panel icon, use the tool tip to identify it.

### OPENING THE PANELS FOR EDITING TYPE

Illustrator provides seven panels for editing type: Character, Character Styles, Glyphs, OpenType, Paragraph, Paragraph Styles, and Tabs. All of them can be opened via the Window > Type submenu; the Glyphs panel can also be opened via the Type menu. Four of them can also be opened via a shortcut, as listed below.

<table>
<thead>
<tr>
<th></th>
<th>Mac OS</th>
<th>Windows</th>
</tr>
</thead>
<tbody>
<tr>
<td>Character</td>
<td>Cmd-T</td>
<td>Ctrl-T</td>
</tr>
<tr>
<td>OpenType</td>
<td>Cmd-Option-Shift-T</td>
<td>Ctrl-Alt-Shift-T</td>
</tr>
<tr>
<td>Paragraph</td>
<td>Cmd-Option-T</td>
<td>Ctrl-Alt-T</td>
</tr>
<tr>
<td>Tabs</td>
<td>Cmd-Shift-T</td>
<td>Ctrl-Shift-T</td>
</tr>
</tbody>
</table>

### USING THE CONTEXT MENUS

When you right-click in the document, depending on where you click and which tool happens to be selected, a menu of context-sensitive commands pops up onscreen. If a command is available on a context menu (or can be executed quickly via a keyboard shortcut), we let you know in our instructions, to spare you a trip to the main menu bar.

Note to Mac OS users: If your mouse doesn’t have a right-click button, hold down Control and click to open the context menu.

### HIDING AND SHOWING PANELS AND TOOLS

<table>
<thead>
<tr>
<th>Hide or show all the currently open panels, including the Tools panel and tearoff toolbars</th>
<th>Tab</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hide or show all the currently open panels but not the Tools panel or tearoff toolbars</td>
<td>Shift-Tab</td>
</tr>
</tbody>
</table>
Using the Tools panel

In addition to the tools on the Tools panel, which are used for creating and editing objects, you will also find color controls, a menu or icons for choosing a drawing mode, and a menu for choosing a screen mode. If the panel is hidden, choose Window > Tools to display it. To convert the panel layout from single column to double column or vice versa, either click the double arrowhead at the top or double-click the top bar.

Click once on a visible tool to select it, or click and hold on a tool that has a tiny arrowhead to choose a related tool from a fly-out menu. You can cycle through tools on the same menu by Option/Alt clicking the visible tool.

To create a tearoff toolbar for a group of related tools, press and hold on the arrowhead for a tool, then click the vertical tearoff bar on the right edge of the menu. A–B To dock tearoff toolbars together, drag one tearoff toolbar to the side of an existing one and release when the vertical drop zone line displays. C–D To make a tearoff toolbar vertical instead of horizontal, click the double-arrow E–F or double-click the top bar. To close a docked tearoff toolbar, drag it by its gripper bar out of its dock, then click its close button (x).

To access a tool quickly, use the letter shortcut that is assigned to it. The shortcuts are listed in parentheses on the next two pages, and also in the tool tips onscreen. G (Note: If the tool tips aren’t displaying, go to Illustrator/Edit > Preferences > General and check Show Tool Tips.)

Some tools can also be accessed temporarily via a toggle key. For example, pressing Cmd/Ctrl turns the current tool into a temporary selection tool. You’ll learn many tool toggles as you proceed through this book.

To turn the tool pointer into a crosshairs icon for more precise positioning, go to Illustrator/Edit > Preferences > General and check Use Precise Cursors. Or if you prefer to keep that preference off, you can turn the pointer to a crosshairs icon temporarily by pressing the Caps Lock key.

You can choose options for the current tool from the Control panel (see page 43). Some tools, such as the Paintbrush and Pencil tools, have a related options dialog, which opens when you double-click the tool or when you click the tool and then press Return/Enter.
The Tools panel illustrated

**Selection (V)** Selects, moves, and transforms entire objects

**Magic Wand (Y)** Selects objects based on their color and opacity attributes

**Pen (P)** Draws paths that are composed of curved and/or straight segments

**Line Segment (↓)** Draws separate straight lines at any angle

**Paintbrush (B)** Creates Calligraphic, Scatter, Art, Bristle, or Pattern brush strokes

**Blob Brush (Shift-B)** Creates closed freehand shapes (or reshapes them)

**Rotate (R)** Rotates objects

**Shape Builder (Shift-M)** Combines objects

**Mesh (U)** Creates and edits multicolored mesh objects

**Eyedropper (I)** Samples and applies paint or type attributes

**Symbol Sprayer (Shift-S)** Sprays symbol instances into a set

**Artboard (Shift-O)** Creates and document artboards

**Hand (H)** Moves the document in its window

**Fill (press X to toggle or click to activate)** The color, gradient, or pattern that fills the inside of a path

**Default Fill and Stroke (D)** Sets the fill color to white and the stroke to black 1 pt.

**Gradient (>)** Resets the fill or stroke to the last gradient

**Color (<)** Resets the fill or stroke to the last solid color

**Direct Selection (A)** Selects and reshapes objects by their anchor points and segments

**Lasso (Q)** Selects individual points and segments on a path by dragging around them

**Type (T)** Creates and edits horizontal type

**Rectangle (M)** Draws rectangles and squares

**Pencil (N)** Draws freehand paths

**Eraser (Shift-E)** Erases sections of objects

**Scale (S)** Enlarges and shrinks objects

**Free Transform (E)** Rotates, scales, reflects, shears, distorts, or applies perspective to objects

**Perspective Grid (Shift-P)** Puts objects into one-, two-, or three-point perspective

**Gradient (G)** Changes the position, length, radius, or angle of existing gradients

**Blend (W)** Creates shape and color blends between objects

**Column Graph (J)** Creates column graphs

**Slice (Shift-K)** Defines slice areas of a document

**Zoom (Z)** Changes the zoom level of a document

**Swap Fill and Stroke (Shift-X)** Swaps the current fill and stroke colors

**Stroke (press X to toggle or click to activate)** The color or pattern that's applied to a path

**None (/)** Sets the current stroke or fill color to None

**Drawing modes**: Draw Normal, Draw Behind, or Draw Inside (Shift-D)

**Screen modes** (F) Change the size of the document window and control the display of Illustrator features
The tearoff toolbars*

Convert Anchor Point (Shift-C) Converts corner points to smooth points, and vice versa

Add Anchor Point (+) Delete Anchor Point (-)

Polar Grid Creates circular grids

Arc Creates curve segments Spiral Creates spiral lines Rectangular Grid Creates rectangular grids

Reflect (O) Creates a mirror reflection of an object

LIQUIFY TOOLS (apply distortion)

Warp (Shift-R) Distorts objects Pucker ScalloplWrinkle

Twirl Bloat Crystallize

Live Paint Selection (Shift-L) Selects sections of a Live Paint group

Live Paint Bucket (K) Recolors faces and edges in a Live Paint group

Measure Measures the distance between two points

SYMBOLISM TOOLS (edit symbol instances)

Symbol Shifter Symbol Scruncher Symbol Sizer Symbol Stainer Symbol Screener Symbol Styler

Symbol Spinner

Print Tiling Positions the printable page

Group Selection Selects whole groups (and nested groups)

Area Type Creates and edits type horizontally inside an object

Vertical Area Type Creates and edits type vertically inside an object

Touch Type (Shift-T) Scales, rotates, and shifts characters manually

Type on a Path Creates and edits type horizontally along a path

Vertical Type on a Path Creates and edits type vertically along a path

Vertical Type on a Path Creates and edits type vertically along a path

Rounded Rectangle Ellipse (L) Flare Creates drawings of lens flares

Twirl Path Eraser Erases sections of paths

Pucker Bloat Scallop Wrinkle

Bloat ScalloplWrinkle

Smooth Smooths path segments

Knife Carves up paths

Scissors (C) Splits paths

Reshape Reshapes sections of paths

Shear Skews objects

Slice Selection Selects slices, for Web output

*The tearoff toolbars for the Perspective Grid and Graph tools aren't illustrated here.
Creating custom tools panels

To conserve space on your screen and for more efficient editing, you can create separate, custom tools panels in which you store just the tools that you use for specific kinds of tasks. For example, you could create separate panels for drawing tools, reshaping tools, or tools for creating gradients and blends. You can open any custom tools panel from the Window > Tools submenu.

To create a custom tools panel: ★

2. In the dialog, enter a name for your tools panel, then click OK. A new panel appears onscreen. Note: All custom tools panels contain a Fill square and a Stroke square, which cannot be deleted.
3. To add tools to your custom panel, drag any tool individually from the standard Tools panel into the tools (top) area of your panel (plus sign pointer). To copy a tool that is in a group but isn’t currently visible on the Tools panel, select the tool first to make it the topmost tool. To quickly cycle through the tools within the current group, hold down Option/Alt and click the topmost tool. Or if you prefer to display all the tools in a group on a separate tearoff toolbar, press and hold on the arrowhead for a tool to open its menu, release, then click the vertical tearoff bar on the right edge of the menu.
4. To delete a tool from the custom panel, drag it out of the panel (a minus sign appears in the pointer).
5. To relocate a tool within a custom panel, drag it to the desired slot, then release it when the vertical drop zone bar appears.

To rename, copy, or delete a custom tools panel: ★

1. Choose Window > Manage Tools Panel.
2. The Manage Tools Panel dialog opens. Click the name of the panel that you want to rename, copy, or delete.
3. Do one of the following:
   - To rename the panel, change the name in the field, then click OK.
   - To duplicate the panel, click the New Custom Tools panel button, type the desired name, then click OK.
   - To delete the panel, click Delete.

OPENING A TEMPORARY PANEL

 ► Click a link (word or letter that has a blue underline) on the Control panel to open a related panel. For example, you could click Stroke to open a temporary Stroke panel, or click Opacity to open a temporary Transparency panel.
    ￭ Click the Stroke or Fill color square on the Control panel to open a temporary Swatches panel, or Shift-click either square to open a temporary Color panel.
    ￭ You can open other temporary panels by clicking a thumbnail or arrowhead. For example, you could click the Style thumbnail or arrowhead to open a temporary Graphic Styles panel.
The Control panel

The Control panel houses many frequently used controls conveniently under one roof, and changes contextually depending on what tool and kind of object are selected. Two of the many variations are shown below. For example, you can use this panel to apply fill and stroke colors; change an object's variable width profile, brush stroke definition, or opacity; apply basic type attributes, such as the font family and point size; align and distribute multiple objects; access controls for editing symbols, Image Trace, and Live Paint objects; and embed or edit linked images.

When no objects are selected, you can use this panel to choose default fill, stroke, brush, style, and opacity settings for the current document and quickly access the Document Setup or Preferences dialog by clicking the button with that name.

To move the Control panel to the top or bottom, respectively, of the Application frame, choose Dock to Top or Dock to Bottom from the menu at the right end of the panel. Or if you prefer to make the panel free-floating, drag the gripper bar on the far left side. To control which options display on the panel, uncheck or check any of the items on the panel menu.

Artboards panel

In addition to listing all the artboards in the current document, the Artboards panel lets you display, create, rename, and duplicate artboards; change their order; rearrange them in the document; choose options for them; change their orientation; and delete them. The Artboard Options dialog opens when you double-click the artboard orientation icon, which is located to the right of the artboard name. See pages 7–12 and 28.
**Align panel**

The buttons on the top two rows of the Align panel align and/or distribute two or more objects along their centers or along their top, left, right, or bottom edges. Objects can be aligned to a selection, an artboard, or a key object (one of the selected objects). Buttons in the lower part of the panel redistribute (equalize) the spacing among three or more objects. See pages 107–108. This panel can also be used to align anchor points (see page 174). Align buttons also appear on the Control panel when two or more objects are selected.

**Appearance panel**

The appearance attributes of an object consist of its fill and stroke color, Stroke panel settings, effects, and Transparency panel settings. The Appearance panel lists the specific appearance attributes and settings for whichever layer, group, or object is currently targeted on the Layers panel. You can use the panel to add extra fill or stroke attributes, edit or remove attributes, apply and edit effects, and edit individual attributes within an applied graphic style.

Using convenient in-panel features, you can edit attributes quickly. For example, you can click a link (blue underlined word) to open a dialog or a temporary panel: Click Stroke to open the Stroke panel, Opacity to open the Transparency panel, or the name of an effect to open its dialog. To open a temporary Swatches panel, click the Stroke or Fill color square, then click the thumbnail or arrowhead (or Shift-click the latter to open a temporary Color panel). See Chapter 14.

**Attributes panel**

The Attributes panel lets you choose overprint options for an object (see page 431), show or hide an object’s center point (see page 105), switch the fill between color and transparency in a compound path (see page 361), or change an object’s fill rule.

You can also use this panel to create a hotspot for Web output. Assign an image map shape and a URL to a selected object, then to verify the URL in the Web browser that is currently installed on your system, click the Browser button.
**Brushes panel**

There are five varieties of decorative brushes that you can apply to paths: Calligraphic, Scatter, Art, Bristle, and Pattern. You can apply a brush either by choosing the Paintbrush tool and a brush and then drawing a shape, or by applying a brush to an existing path.

To personalize your brush strokes, you can create and edit custom brushes. If you modify a brush that’s being used in a document, you’ll be given the option via an alert dialog to update the paths with the revised brush. Brushes on the Brushes panel save with the current document. See Chapter 23.

To open a temporary Brushes panel, click the brush Definition thumbnail on the Control panel, or for a selected Stroke listing on the Appearance panel, click the Brush Definition thumbnail.

**SHOWING OR HIDING PANEL OPTIONS**

Some of the panels in Illustrator have extra options, which you may or may not see at first. To display or show a panel's full options, click the double arrow on its tab (once or twice).

**Character panel**

You will use the Character panel to apply type attributes: font family, font style, font size, leading, kerning, tracking, horizontal scale, vertical scale, baseline shift, character rotation, and special glyphs. You can also use this panel to access the Touch Type tool, choose a language for hyphenation, and set the anti-aliasing method. See pages 267–272, 286, and 287.

When a type tool or a type object is selected, the Control panel also provides some basic type controls. To open a temporary Character panel, click Character on the Control panel.
**Character Styles panel**

A character style is a collection of settings for type characters, including a font family, font style, font size, leading, tracking, and kerning. Unlike paragraph styles, which apply to whole paragraphs, character styles are used to quickly format small amounts of type (such as bullets, boldfaced words, italicized words, or large initial caps) to distinguish them from the main text. When you edit a character style, any text in which it is being used updates accordingly.

Using the Character Styles panel, you can create, apply, edit, duplicate, and delete styles. See pages 284–287. (Compare this panel with the Paragraph Styles panel, which is shown on page 51.)

**Color panel**

In Illustrator, colors are applied to an object’s fill (interior) or stroke (edge). Use the Color panel to mix a global process color, enter a hexadecimal code, or set a tint percentage for a spot or global color. Choose a color model for the panel, such as RGB or CMYK, from the panel menu. Quick-select a color by clicking in the spectrum bar at the bottom of the panel, or click the black, white, or None button. You can expand the bar by dragging the bottom edge downward. See page 117.

To open a temporary Color panel, Shift-click the Fill or Stroke square or arrowhead on the Control panel or the Appearance panel.

**Color Guide panel**

Use the Color Guide panel to generate color schemes from a base color by choosing a harmony rule and/or a variation type (Tints/Shades, Warm/Cool, or Vivid/Muted). You can click any variation swatch to apply it as a fill or stroke color to one or more selected objects. You can also save variations from the Color Guide panel as a group to the Swatches panel, or edit the current color group via the Edit Colors dialog. See pages 115 and 128–130.
**CSS Properties panel**

The CSS Properties panel lists all the character and graphic styles that are being used in the current Illustrator document, as well as the CSS code for the currently selected object(s). If you're designing a Web page and you want to ensure that it is styled correctly, you or a Web developer can copy the CSS code from this panel, and then paste the code into the HTML file. See pages 452–454.

**Flattener Preview panel**

Artwork that contains semitransparent objects must be flattened before it is printed. Using the Highlight menu options in the Flattener Preview panel, you can preview which objects in your document will be affected by flattening, adjust the flattening settings, then click Refresh to preview the effect of the new settings in your artwork. See page 436.

**Glyphs panel**

Using the Glyphs panel, you can find out which character variations (alternate glyphs) are available for any given character in a specific OpenType font, and insert specific glyphs from that font into your document (including glyphs that can't be entered via the keyboard). See page 279.

For the Document Info panel, see page 447.
Gradient panel

The Gradient panel lets you create, apply, and edit gradients, which are soft, gradual blends between two or more colors. You can use the panel to apply a gradient to an object’s fill or stroke, adjust the amount of a color by dragging its stop, choose a different color or opacity value for a selected stop, click below the gradient slider to add new colors, move a midpoint diamond to change the location where two adjacent colors are mixed equally, reverse the gradient colors, change the overall gradient type or angle, or change the alignment of a gradient in an object’s stroke. See Chapter 24.

Graphic Styles panel

The Graphic Styles panel enables you to store and apply collections of appearance attributes, such as multiple solid-color fills or strokes, transparency and overprint settings, blending modes, brush strokes, and effects. Using graphic styles, you can apply attributes quickly and create a cohesive look among multiple objects or documents (similar to how paragraph styles are used with type). See Chapter 16. To open a temporary Graphic Styles panel, click the Style thumbnail or arrowhead on the Control panel.

Info panel

If no objects are selected in the current document, depending on the current tool, the Info panel lists the x/y (horizontal and vertical) location of the pointer. If an object is selected, the panel lists the location of the object, its width and height, and data about its fill and stroke colors (the color components; or the name of a pattern or gradient; or a color name or number, such as a PANTONE PLUS number). While an object is being transformed via a transform tool, the panel lists pertinent information, such as a percentage value for a scale transformation or an angle of rotation. When a type tool and type object are selected, the panel displays type specifications. When the Measure tool is used, the Info panel opens automatically and lists the distance and angle the tool has just calculated.
Image Trace panel

The Image Trace feature detects and traces areas of color and shade in a raster image that is opened or placed into Illustrator, such as a Photoshop, TIFF, or JPEG image or scanned artwork, and converts those areas to Illustrator paths.

You can choose from a wide array of tracing options on the Image Trace panel prior to the tracing—and because a tracing is “live,” you can also use the panel to fine-tune the results. You can use a built-in tracing preset (predefined settings) as a starting point, or create and apply custom presets. Among the numerous settings that you can specify are a mode (black and white, grayscale, or color), a color palette, the number of resulting colors, whether fill and/or stroke colors are produced, and the precision with which the image is traced. See Chapter 17.

Kuler panel

Kuler (pronounced “cooler”) is a free, Web-hosted Adobe application that lets users create, upload, and comment on color groups, called color themes. The Kuler panel in Illustrator displays the themes that you have created or designated as favorites on Kuler.adobe.com or that you have created using the Adobe Kuler app on an iPhone. Via the panel, you can apply colors directly to objects, or you can add colors to the Swatches panel for later use. To show the panel, choose Window > Kuler. See pages 133–135.
Layers panel

The indispensable Layers panel lets you add and delete layers and sublayers in a document, and create layer groups. You can also use this panel to select, target, restack, duplicate, delete, hide, show, lock, unlock, merge, change the view for, or create a clipping set for a layer, sublayer, group, or individual object. When your artwork is finished, you can use a command on the panel menu to flatten the document into one layer or release all the objects to separate layers for export as a Flash animation. See Chapter 13.

Links panel

When you place an image from another application, such as Photoshop, into an Illustrator document, you can opt to have Illustrator embed a copy of the image into the file (and thereby increase the file size but allow the program to color-manage it) or merely link the image to your document (and minimize the file size but require the original file to be available for print output). Using the Links panel, you can monitor the status of linked images, convert a linked image to an embedded one (or vice versa), open a linked image in its original application for editing, update an edited image, restore the link to an image that is missing or modified, and view image data. See pages 314–317.

Magic Wand panel

The Magic Wand tool selects objects that have the same or a similar fill color, stroke color, stroke weight, opacity, or blending mode as the currently selected object. Using the Magic Wand panel, you specify which attributes the tool may select and set a tolerance value for each attribute. For example, if you were to check Opacity, choose an opacity Tolerance of 10%, then click an object that has an opacity of 50%, the tool would find and select objects in the document that have an opacity between 40% and 60%. See page 99.

Navigator panel

The Navigator panel has two main functions. To use it to move the current document in its window, drag or click in the proxy preview area (red outlined box). To change the document zoom level, use the zoom controls at the bottom of the panel. To both zoom to, and bring a specific area of, a document into view, Cmd-drag/Ctrl-drag in the proxy preview area.
OpenType panel

Among the Roman OpenType font families that ship with Illustrator, the fonts that contain an expanded character set and a large assortment of alternate glyphs are labeled with the word “Pro.” By clicking a button on the OpenType panel, you can specify which alternate characters (glyphs) will appear in your text when you type the requisite key or keys. The special characters for a given font may include ligatures, swashes, titling characters, stylistic alternates, ordinals, and fractions. You can also use the panel to specify options for numerals, such as a style (e.g., tabular lining or oldstyle) and a position (e.g., numerator, denominator, superscript, or subscript). See page 280.

Paragraph panel

Use the Paragraph panel to apply settings that affect entire paragraphs, such as horizontal alignment, indentation, spacing before or after, and automatic hyphenation. Via the panel menu, you can choose hanging punctuation and composer options and open a dialog for choosing justification or hyphenation options. See pages 273, 277–279, and 284.

The Align Left, Align Center, and Align Right buttons are also available on the Control panel when a type object is selected. To open a temporary Paragraph panel, click Paragraph on the Control panel.

Paragraph Styles panel

A paragraph style is a collection of paragraph specifications (including horizontal alignment, indentation, spacing before or after, word spacing, letter spacing, hyphenation, and hanging punctuation), as well as character attributes, such as the font family, font style, and font size. When you apply a paragraph style to one or more selected paragraphs, the type is reformatted with the specifications in that style. When you edit a paragraph style, the type in which it is being used updates accordingly. With paragraph (and character) styles, you can typeset text quickly and ensure that the formatting is consistent. Use the Paragraph Styles panel to create, store, apply, edit, duplicate, and delete paragraph styles for the current document. See pages 284–287.
Pathfinder panel

Depending on how they are applied, the Shape Mode commands on the top row of the Pathfinder panel combine selected, overlapping objects into one or more standard paths or into a compound shape. The Expand button converts a compound shape into either a path or a compound path (the latter if the command originally produced a cutout shape). The Pathfinder buttons on the bottom row of the panel produce flattened, cut-up shapes from multiple selected objects. See pages 362–364.

Pattern Options panel

Via the Pattern Options panel, along with some intuitive on-image controls, you can create and edit seamless patterns. When you create a pattern, it appears automatically on the Swatches panel for the current document. You can apply any pattern swatch in the Swatches panel to an object’s fill (interior) or stroke (edge).

The Pattern Options panel lets you change the pattern tiling configuration (Grid, Brick, or Hex); adjust the spacing between tiles; and for objects that straddle the tile boundary and overlap one another, control which objects are in front. You can also choose preview options for pattern-editing mode, including the number of copies that display, to what extent the copies are dimmed, and whether the tile and/or swatch boundaries display. See pages 137–144.

Separations Preview panel

The Separations Preview panel gives you an idea of how the individual C, M, Y, and K color components in a CMYK document will separate to individual plates during the commercial printing process. You can use the panel to check that a color is properly set to knock out colors beneath it in your artwork, or to check whether a color is properly set to overprint on top of the other colors. Other uses for the panel are to monitor the use of spot colors in the artwork, to verify that any spot color is set to knock out colors beneath it, and to determine whether a specific black is a rich black (a mixture of C, M, Y, and K inks) or a simple black that contains only the K component. See pages 432–433.
Stroke panel

Stroke settings control the appearance of an object’s path (edge). By using the Stroke panel, you can specify a stroke weight (thickness), cap (end) style, and corner (join) style, and an alignment option to control the position of the stroke on the path. You can also use the panel to create a dashed (or dotted) line or border, apply an arrowhead and/or tail style, and change the stroke width profile. See pages 122–124 and 166. To open a temporary Stroke panel, click Stroke on the Control or Appearance panel.

Swatches panel

Use the Swatches panel to choose, store, and apply solid colors, patterns, gradients, and color groups. If you click a swatch, it becomes the current fill or stroke color (depending on whether the Fill or Stroke square is active on the Tools panel and Color panel), and it is applied to all currently selected objects.

Double-clicking a swatch opens the Swatch Options dialog, in which you can change the swatch name or change its type to global process, nonglobal process, or spot. See pages 116, 118, 120, 126–129, and 136. To open a temporary Swatches panel, click the Fill or Stroke square or arrowhead on the Control or Appearance panel.

Symbols panel

Symbols are Illustrator objects that are stored on the Symbols panel and save with the current document. Using symbols, you can quickly and easily create a complex collection of objects, such as a bank of trees or clouds. To create one instance of a symbol, you simply drag from the Symbols panel onto the artboard; to assemble multiple instances quickly into what is called a symbol set, you use the Symbol Sprayer tool.

The other symbolism tools let you change the position, stacking order, proximity, size, rotation angle, or transparency of multiple instances in a set, or gradually apply a color tint or graphic style — while maintaining the link to the original symbol on the panel. If you edit the original symbol, all instances of that symbol in the document update automatically. See Chapter 28.
**Transparency panel**

You can use the Transparency panel to change the blending mode or opacity of a layer, group, or individual object. The Make Mask button applies the opacity value and grayscale equivalent of a color (or colors), gradient, or pattern in the topmost object to underlying selected objects, and optionally hides sections of those objects that extend beyond its edges. See Chapter 27.

To open a temporary Transparency panel, click the Opacity link on the Control or Appearance panel. You can also change the opacity of an object directly via the Control panel.

**Tabs panel**

The only way to align columns of text precisely is by using tabs and the Tabs panel. Using the panel, you can insert, move, and change the alignment of custom tab markers, specify a leader (such as a period character, to produce a dotted line), and specify a character for your text to align to (such as a decimal point). See page 288.

**Transform panel**

The Transform panel lists the location, width, height, rotation angle, and shear angle of the currently selected object, and can be used to change those values. By clicking a reference point, you can control what part of the object the transformations are calculated from. The panel can also be used to align selected objects to the pixel grid. Via commands on the panel menu, you can control whether just the object, the object and a fill pattern, or just the fill pattern is transformed. See pages 152–153.

A reference point icon and X, Y, W, and H fields also appear on the Control panel when one or more paths are selected. To open a temporary Transform panel, click the X, Y, W, or H link (or if those fields aren’t showing, click the word “Transform”).
acquiring images
  with drag-and-drop method, 307–308, 318
dragging from Bridge, 318
importing, 312–313
methods, 307–308
with Open command, 308
with Place command, 309–310
Add Anchor Point tool, 41, 161
Adobe Typekit dialog, 63
AI (Adobe Illustrator) format, 13, 442
alert dialogs, 63, 240, 309
Align panel, 44, 107–108
aligning
  anchor points, 108, 174
  artboards, 11
center points, 102
Control panel features, 107
objects, 81, 84, 107–108
paragraphs, 282
shapes within symbol instances, 387
with Smart Guides, 102–103
strokes on paths, 122
symbols, to pixel grid, 389
text, 288
Anchor Point tool, 165
anchor points
  adding, 161–163
  adjusting while drawing with Pen tool, 302
aligning, 108, 174
  converting, 159–160, 303–306
  corner, 157, 303
deleting, 164
deselecting, 94
discontinuous width, 168
dragging, 172
duplicating, 167
  joining endpoints into, 175
  moving, 158
  multiple, marquee, 172
  selecting, 94, 98, 158
  smooth, 157, 303
  unselceted, 94
angles, constrain, 151, 408, 409
ANPA colors, 120
anti-aliasing, 270
apostrophes, 278
appearance attributes
  adding graphic styles to, 224
  adding to stroke or fill, 204
  applying, 200–203, 294
  clearing, 205
default settings, 201
defined, 199
deleting, 205
duplicating, 206
editing, 200, 204
expanding, 206
fill, 224
  functions of, 199
  hiding, 205
Appearance of Black preferences, 420
Appearance panel
  Add New Effect menu, 155, 176, 204,
  208–209, 211, 213
  Add New Fill button, 203, 350
  Add New Stroke button, 203, 295, 350
  Brush Definition menu, 204
  Characters option, 379
  Clear Appearance button, 205, 223
deciphering, 202
defined, 44
  Delete Selected Item button, 205, 379
  Fill and Stroke squares, 119, 200
  Fill listing, 379
  illustrated, 44, 199
  New Art Has Basic Appearance option, 223
  Opacity link, 201, 204, 378
  Pathfinder submenu, 368
  Redefine Graphic Style option, 226
  Reduce to Basic Appearance command, 205
  Stroke Weight controls, 122
Type listing, 379
Application bar, 4, 24, 26, 34
Application frame, 23–25
Arc tool, 41
area type, 254–255, 262–264
Area Type Options dialog, 255
Area Type tool, 41, 251–252, 254
Art Brush Options dialog, 328–329, 340
Art brushes. see also brushes
  applied to path, 320
creating, 328–329
editing, 328–329, 340
  images in, 330
  library, 321
  stroke, scaling, 330
Artboard Options dialog, 8, 12
Artboard tool, 7, 8, 9, 40
artboards, 2–3, 7–13, 28, 100
Artboards panel, 8, 9, 10, 43
artwork
  assigning colors to, 403–404
  brightness, 402
  creating from building blocks, 81
  creating via Color Guide panel, 127
  exporting as CSS code, 452–454
  fitting artboards to, 9
  inverting colors in, 137
  oversized, printing, 423
  pixel-perfect, creating, 84
  reducing colors in, 403–404
  replacing colors in, 136
  sharing on Behance, 458
  snapping to pixel grid, 30
  as tiled pages, 423
Assign Profile dialog, 21
Attributes panel, 44, 105, 366
baseline shift, 290, 412
Behance, 458
black, 117, 420, 432–433
bleed values, 424
Blend tool, 40
blending modes, 213, 377–380
Blob tool, 41
Blob Brush tool, 40, 89–90, 170–171, 180
BMP file format, 446
bounding box, 103, 147, 156, 373
Bridge, 55–74. see also workspaces (Bridge)
cache, 74
collections, 69–70
dragging images from, 318
file management, 74
filtering display of thumbnails, 72
finding files with, 68
going to Illustrator from, 66
interface colors, 66
keywords, 73
launching, 4, 56
layouts, saving, 64
opening files from, 62–63
panels, 56, 64
Path bar, 60, 62
previewing graphics in, 60–61
rating and labeling thumbnails, 71
reopening recently opened files with, 62
search results, 68
sorting thumbnails, 72
subkeywords, 73
synchronizing color settings via, 20
unless noted otherwise, the entries in this index pertain to Illustrator.
CALLIGRAPHIC BRUSHES, 320, 331–333

BRUSH STROKES
Art brushes, 328–330
Bristle brush, 331–333
Calligraphic brush, 324–325, 341
defining, 341
editing, 323, 342
expanded, 323, 342
methods, 319
painting inside objects, 338
Pattern brushes, 334–337
removing from object, 322
restoring, 341
scaling, 341
Scatter brush, 326–327
uniform width, restoring, 330
BRUSHES, 319–342. see also specific types
of brushes
appending to Brushes panel, 321
applying to existing paths, 320
colorization methods, 339
deleting, 342
duplicating, 339
editing, 340
loading from library, 321
types of, 319
variations, creating, 327
BRUSHES PANEL, 45, 319, 321–322,
341–342

CALLIGRAPHIC BRUSH OPTIONS DIALOG, 324–325
CALLIGRAPHIC BRUSHES, 320–321, 324–325.
see also brushes

CANVAS, 6
caps, stroke, 122–123
center point, 102, 105

CHARACTER PANEL
Anti-aliasing menu, 270
Baseline Shift option, 290
caps buttons, 271
Character Rotation value, 264
defining, 45
Font Family menu, 269, 272
Font Size option, 274
Font Style menu, 269
Horizontal Scale feature, 274
illustrated, 45
Kerning area, 276
Leading option, 275

strike-through and underline buttons, 271
superscript and subscript buttons, 271
tracking area, 276
vertical scale feature, 274

CHARACTER STYLE OPTIONS DIALOG, 286

character styles, 284–287
appearance attributes, 285
creating and applying, 284
defined and illustrated, 284
deleting, 286–287
editing, 285, 286
loading from one document to another,
285
in styling type quickly, 270
text, removing overrides from, 285

CHARACTER STYLES PANEL, 46, 284–285,
286–287

characters
adding multiple strokes to, 295
baseline shift, 290
hidden, 263
inserting and deleting, 252
leader, 289
OpenType, 280

CHARCOAL EFFECT, 218
circles, type on, 265–266
CLIPBOARD, 105, 419

CLIPPING PATHS, 369, 373–374

CLIPPING SETS, 369–376

CMYK COLOR MODE, 2, 17, 115, 119, 318

COLOR BRUSH OPTIONS DIALOG, 130
COLOR GUIDE OPTIONS DIALOG, 130
COLOR GUIDE PANEL, 46, 117, 130–132
COLOR MANAGEMENT, 15–22, 430
COLOR MODELS, COLOR PANEL, 119
color modes, document, 2

COLOR PANEL
applying colors via, 116, 119
color models, 119
defining, 46
Fill and Stroke squares, 119, 121, 344,
345
Grayscale option, 119
illustrated, 46
Spot Color button, 427

COLOR PICKER, 114, 117
COLOR PROFILES, 16, 18, 21
COLOR REDUCTION OPTIONS DIALOG, 406
COLOR SEPARATIONS, 426
color settings, 17–18, 20, 232–234
COLOR SETTINGS DIALOG, 15, 17–20
color spaces, 16, 17–18
color themes. see Kuler themes
COLOR UNIVERSAL DESIGN (CUD)
guidelines, 18
color variations. see Color Guide panel
COLOR-BLIND, DESIGNING FOR
COLORIZATION TIPS DIALOG, 339
COLORS
adding from Color Guide panel, 132
ANPA, 120
applying, 116–117, 119–120, 125
assigning to artwork, 403–404
blending, 138
Bridge interface, 66
choosing quickly, 75
DIC Color Guide, 120
fill, 85, 113, 116–118, 137
FOCOLTONE, 120
gradient, 348, 349
for grayscale images, 137
guide, 112
hexadecimal, 115
HKS, 120
interface, 24
inverting, 137
layer selection border, 183
limiting to libraries, 405
numerical definition of, 119
output medium, 114–115
PANTONE PLUS, 114, 120
for print output, 114–115
print settings, 427
process, 121, 128
proofing, 22
reassigning, 404
reducing in artwork, 405–406
registration, 439
RGB, 115
sampling, 125

CACHE (Bridge), 74
calibration, display, 16
calligraphic brush options dialog, 324–325
calligraphic brushes, 320–321, 324–325.
see also brushes
canvas, 6
caps, stroke, 122–123
center point, 102, 105

character panel
Anti-aliasing menu, 270
Baseline Shift option, 290
caps buttons, 271
Character Rotation value, 264
defining, 45
Font Family menu, 269, 272
Font Size option, 274
Font Style menu, 269
Horizontal Scale feature, 274
illustrated, 45
Kerning area, 276
Leading option, 275

Strikethrough and Underline buttons, 271
Superscript and Subscript buttons, 271
Tracking area, 276
Vertical Scale feature, 274

Character Style Options dialog, 286

character styles, 284–287
appearance attributes, 285
creating and applying, 284
defined and illustrated, 284
deleting, 286–287
editing, 285, 286
loading from one document to another,
285
in styling type quickly, 270
text, removing overrides from, 285

Character Styles panel, 46, 284–285,
286–287

characters
adding multiple strokes to, 295
baseline shift, 290
hidden, 263
inserting and deleting, 252
leader, 289
OpenType, 280

Charcoal effect, 218
circles, type on, 265–266
Clipboard, 105, 419
clipping paths, 369, 373–374
clipping sets, 369–376
adding objects to, 375
creating, 369–372
defined, 369
guidelines, 369
layer-level, 372, 374
object-level, 370–371
releasing, 376
removing objects from, 375
restacking objects in, 375
selecting, 373

CMYK color mode, 2, 17, 115, 119, 318
collections (Bridge), 69–70

Collections panel (Bridge), 56, 69–70
collection colors, 130

color groups
active, 130–131
assigning to artwork, 403
creating, 127, 132, 237, 399–400
deleting, 404
Kuler, 405
removing colors from, 404
restacking and renaming, 127
saving, 400, 402

Color Guide Options dialog, 130
Color Guide panel, 46, 117, 130–132
color management, 15–22, 430
color models, Color panel, 119
color modes, document, 2

Color panel
applying colors via, 116, 119
color models, 119
defining, 46
Fill and Stroke squares, 119, 121, 344,
345
Grayscale option, 119
illustrated, 46
Spot Color button, 427

Color Picker, 114, 117
color profiles, 16, 18, 21
color reductions options dialog, 406
color separations, 426
color settings, 17–18, 20, 232–234
color settings dialog, 15, 17–20
color spaces, 16, 17–18
color themes. see Kuler themes
Color Universal Design (CUD)
guidelines, 18
color variations. see Color Guide panel
color-blind, designing for, 18
Colorization Tips dialog, 339
colors
adding from Color Guide panel, 132
ANPA, 120
applying, 116–117, 119–120, 125
assigning to artwork, 403–404
blending, 138
Bridge interface, 66
choosing quickly, 75
DIC Color Guide, 120
fill, 85, 113, 116–118, 137
FOCOLTONE, 120
gradient, 348, 349
for grayscale images, 137
guide, 112
hexadecimal, 115
HKS, 120
interface, 24
inverting, 137
layer selection border, 183
limiting to libraries, 405
numerical definition of, 119
output medium, 114–115
PANTONE PLUS, 114, 120
for print output, 114–115
print settings, 427
process, 121, 128
proofing, 22
reassigning, 404
reducing in artwork, 405–406
registration, 439
RGB, 115
sampling, 125
saving as swatches, 118
spot, 121, 128, 210
stroke, 85, 113, 116–118
surprises, avoiding, 120
tint percentage, changing, 121
transparency grid, 381
TRUMATCH, 114, 120
variation, 130–132
for Web output, 115
Column Graph tool, 40
combining objects
with Blob Brush tool, 170
with commands, 177
with Compound Path command, 365–367
with Pathfinder commands, 362–364
with Shape Builder tool, 355–359
with Shape Mode commands, 359–361
Compound Path command, 365–367
compound paths, 364–367
compound shapes, 359, 361, 364
compression
GIF file, 448
JPEG file, 451
PDF file, 444–445
saving files in AI format, 13
for Web, 448
constrain angle, 151, 408, 409
content menus, 38
Content panel (Bridge), 56, 60, 64–65, 70
Control panel
align features, 42, 107
Anchors: Remove Selected Anchor Points button, 164
Break Link option, 397
Brush Definition menu, 43, 320, 322
in choosing tool options, 39
Connect Selected Endpoints button, 43, 175
Convert Selected Anchor Points to Corner button, 43, 160, 304
Convert Selected Anchor Points to Smooth button, 43, 159, 304
Cut Path at Selected Anchor Points button, 43, 178
defined and illustrated, 43
Document Setup button, 434
Edit Clipping Path button, 373
Edit Contents button, 373
Edit Symbol option, 391
Embed option, 315
Expand option, 237, 249
Fill color square, 42, 43, 116
Font Family menu, 272
Font menu, 252
Font Size option, 252
Font Style option, 252
Gap Options menu, 248
Hide Handles for Multiple Selected Anchor Points button, 43
Horizontal Align buttons, 43, 174, 175
Isolate Selected Objects button, 98
Landscape button, 10
Merge Live Paint option, 247
Move/Copy Artwork with Artboard button, 8, 9
moving, 43
moving artwork via, 153
Opacity option, 43, 378
option locations, 43
Portrait button, 10
Preferences option, 407
Presets menu, 7, 10
Recolor Artwork button, 43, 399, 401
Remove Selected Anchor Points option, 43
Replace option, 389
scaling with, 153
Select Similar Options menu, 95, 136
Show Handles for Multiple Selected Anchor Points option, 43
splitting path with, 178
Stroke color square, 42, 89, 116
Stroke Weight area, 43, 122
tracking options, 231
Variable Width Profile menu, 43, 166
W, H, X, Y fields, 153
Convert Anchor Point tool, 41, 159–160, 304
Convert to Shape effect, 211
copying, see duplicating
corner points. see also anchor points
converting endpoints to, 163
converting smooth points to, 160, 303
converting to smooth points, 159, 304
declared and illustrated, 157
corners, 78, 79, 122–123
Creative Cloud
commands for managing files, 457
downloading settings from, 455–456
Kuler panel synchronization, 134
sharing, renaming, moving, archiving files via, 457
signing out of, 457
syncing settings, 455–456
Typekit fonts and, 272
uploading files and settings to, 455, 456–457
crop marks, 438–439
Crystallize tool, 41
CSS code, 452–454
CSS Properties panel, 47, 453–454
curves
drawing with Pen tool, 301
reshaping, 158, 165
smoother, 161, 301
custom tools panels, 42
Custom Transparency Flattener Options dialog, 435–436
D
dashed strokes, 124
Delete Anchor Point tool, 41, 164
deuteranopes, 18
DIC Color Guide colors, 120
Diffuse Glow effect, 218
Direct Selection tool
defined, 40
deselecting with, 94
in isolating objects, 98
Live Corner widget, 92
reshaping with, 158–159, 165
selecting with, 94
uses, 92
direction handles, 157, 158, 160
Discard White Overprint, 434
discontinuous width points, 168
displays, calibrating, 16
distortion, applying, 149
distributing objects, 107–108
Divide Objects Below command, 179
dividing objects, 358
docks, panel, 32–34
document Info panel, 447
document Raster Effects Settings dialog, 216, 439
document Setup dialog, 434
document windows, 23, 25–26, 28, 75
documents
anatomy of, 6
areas, moving into view, 28
artboards, 7–12
color mode, 2
color profiles, 16, 21
creating, 2–3
flattening settings preview, 436
information, viewing, 447
orientation, 2
preferences, setting, 25
templates, 4–5
views, 30–31
zoom level, changing, 27
dotted strokes, 124
Draw Behind mode, 186
Draw Inside mode, 338, 371, 375
Draw Normal mode, 186
drawing
with Blob Brush tool, 89
curves, 301
exercise, glass of beer, 180
freehand, 85–90
geometric objects, 76–82
knife with Pen tool, 305–306
line segments, 83
with Paintbrush tool, 87
with Pen tool, 299–302
with Pencil tool, 86
polygons, 300
with Reshape tool, 172
drawing modes, 40, 75, 371, 375
Drop Shadow effect, 214
duplicating
anchor points, 167
appearance attributes, 200, 204
artboards, 8–9
brushes, 339
CSS code, 453
custom tools panels, 42
effects, 210
files (Bridge), 74
groups, 104–105, 192
layers, 192
objects, 104–105, 192
styles, as CSS code, 453
sublayers, 192
swatches, 128
symbol instances, 387
type, 258
type objects, 258, 260
workspaces, 36

deleting
appearance attributes, 200, 204
Art brushes, 328–329, 340
Bristle brushes, 331–332
brush strokes inside objects, 338
brushes, 340
Calligraphic brushes, 324–325
colors, 285–286
effects, 210
gratings, 353
graphic styles, 225
linked images, 314
objects in opacity masks, 384
paragraph styles, 285–286
Pattern brushes, 337, 340
patterns, 144–145
preset, 437
Scatter brushes, 326–327
selecting type for, 268
Smart Collections, 69
swatches, 120, 405
symbols, 391
threaded type, 260
transformations, 155
workspaces, 35

Effect Gallery, 208, 217–218
Effect menu
applying effects with, 209
Blur submenu, 214
Convert to Shape submenu, 211
Crop Marks command, 438
Distort & Transform submenu, 215
Document Raster Effects command, 216
Document Raster Effects Settings
command, 439
Effect Gallery command, 217
illustrated, 208
Path submenu, 106
Stylize submenu, 159, 211–214, 293
Warp submenu, 210
effects, 207–218
applying, 207–209
Charcoal, 218
Convert to Shape, 211
deleting, 210
Diffuse Glow, 218
Drop Shadow, 214
duplicating, 210
editing, 210
Feather, 293
Free Distort, 296
Gaussian Blur, 214
Grain, 218
Inner Glow, 213
last used, applying, 210
multiple, applying, 208, 210
Outer Glow, 213
Pathfinder, 368
Photoshop, 208, 217–218
Plastic Wrap, 218
resolution for, 439
Rough Pastels, 218
Roughen, 215
Scribble, 209, 212
spot colors for, 210
Squeeze, 210
Twist, 207, 215
Zig Zag, 176
Ellipse tool, 41, 76, 180, 265
embedded images, 308, 315, 317
Embedded Mismatch alert dialog, 63, 309
EMF file format, 446
dependencies, 163, 175, 178
Eraser tool, 40, 171, 173
Essentials workspace (Bridge), 59
Expand dialog, 354, 398
expanding
appearance attributes, 205
brush strokes, 323, 342
compound shapes, 361
gradient fills, 354
gradient strokes, 354
Live Paint groups, 249–250
symbol instances, 398
symbol sets, 398
tracing, 237–238
tracking into paths, 237–238
Export dialog, 446
exporting
artwork, as CSS code, 452–454
Bridge cache, 74
CSS code as files, 453–454
formats, 446–447
Illustrator files, 446
to Photoshop, 454
semitransparent objects, 434–436
settings, 456
transparency, 379
for the Web, 448–451
extracting shapes, 357
Eyedropper tool, 40, 125
faces, 244–245, 247
Favorites panel (Bridge), 56, 61
Feather effect, 293
file formats
AI, 13, 442
BMP, 446
EMF, 446
for export, 442
GIF, 442, 448, 450
imported into Illustrator, 308
JPEG, 442, 448, 451
PDF, 442–445
PNG, 447
SWF, 447
TIFF, 447
WMF, 446
File Handling & Clipboard preferences, 314, 419
File Info dialog (Bridge), 73
file management (Bridge), 74
File menu
Color Mode submenu, 115
Document Color Mode submenu, 422
Export command, 446
New command, 2
New from Template command, 4
Open command, 55
Place command, 229, 259, 309, 310, 330, 334
Print command, 422
Revert command, 14
Save a Copy command, 14
Save As command, 13, 21, 197
Save as Template command, 5
Save command, 14
Save for Microsoft Office command, 447
Save for Web command, 449, 450
files
archiving via Creative Cloud, 457
closing quickly, 14
flatness setting, 428
HTML, 452–454
managing via Creative Cloud, 456–457
new, basing on settings of existing, 2
opening
from Bridge, 62–63
from Illustrator, 55
from Macintosh Desktop/Windows Explorer, 55
as untitled documents, 4–5
packaging, 440–441
PDF compatible, 13
resaving, 14
reverting to last version, 14
saving, 5, 13, 442–445
sharing via Creative Cloud, 457
uploading to Creative Cloud, 456–457
files (Bridge)
cache, 74
copying and moving, 74
finding, 68
metadata, viewing, 61
quick search for, 68
renaming and deleting, 74
reopening recently opened, 62
fill colors
applying, 116–117
blending, 138
choosing, 85
current display, 113
in Live Paint groups, 246
white, applying, 117
fills
adding attributes to, 204
attributes, applying, 203
blending modes, 379
defined, 85
gradient, 344
opacity, 379
types of, 85
Filmstrip workspace (Bridge), 58, 66
Filter panel (Bridge), 72
Find dialog (Bridge), 68
Find Font dialog, 297
fitting type, 277
Flare tool, 41
Flash (swf) file format, 447
flatness, 428
Flatten Artwork command, 198
Flattener Preview panel, 47, 436
flattening
flatness versus, 428
layers, 198
options, 431
selective, 437
semitransparent objects and, 434
setting, previewing, 436
transparency control, 434–436
FOCOLTONE colors, 120
folders (Bridge), 60–61, 74
Folders panel (Bridge), 56, 60
Font Problems alert dialog, 4
font size, 252, 274
fonts
activating, 297
download settings, 428
family, changing, 269–270
loading onto computer, 297
missing, 297–298
preferences, 412
style, changing, 269–270
for type tool, 252
Typekit, 272–273, 298
Free Distort effect, 296
Free Transform tool, 40, 148–149, 293
freehand drawing, 85–90
Full Screen Mode, 29
Full Screen Mode with Menu Bar, 29
G
Gap Options dialog, 248
General options (Print dialog), 422–423
General preferences, 408–409. see also preferences
General preferences (Bridge), 61
GIF format, 448, 450
glyphs, 279–280
Glyphs panel, 47, 279
Gradient panel
Add to Swatches button, 348, 350
Angle option, 295
defined and illustrated, 48
editing gradients via, 353
Gradient square, 344, 350
Reverse Gradient button, 349
Stroke buttons, 345
type menu, 345, 348
Gradient tool, 40, 349, 351–352
gradients, 343–354
angle of, 351–352
applying, 116, 343–345, 350
aspect ratio, 352
colors, editing, 349
colors, swapping, 348
color-separating, 427
creating, 348
defined, 343
editing via Gradient panel, 353
expanding into paths, 354
length, 351–352
library, 344
linear, 343, 348
loading onto Swatches panel, 344
naming, 348
position, 351–352
radial, 343, 348
reapplying, 350
repositioning, 352
saving, 348, 350
scaling, 351
shape, 352
spreading across multiple objects, 353
stops, 349
two-color, 348
type, changing, 345
Grain effect, 218
graphic styles, 219–228
  adding to existing attributes, 224
  applying, 222, 224
  attribute modification and, 220
  benefits, 220
  creating, 225
  deleting, 227
  duplicate, modifying, 225
  editing, 225
  for future objects, 223
  illustrated examples, 220
  library, creating, 228
  links, breaking, 228
  loading, from library, 221
  multiple, applying, 224
  naming, 222, 225
  redefining, 220, 226–227
  removing, 223
  saving dashed strokes as, 124
  settings, editing, 227
  thumbnails, 222
Graphic Styles panel
  Break Link to Graphic Style button, 228
  Default Graphic Style thumbnail, 223
  defined, 48
  Delete Graphic Style button, 227
  displaying, 219
  Graphic Styles Libraries menu, 221, 228
  illustrated, 48, 219
  New Graphic Style button, 225
Graphics options (Print dialog), 428–429
grayscale images, colorizing, 137
grid, document, 112, 381
Group Selection tool, 41, 92
groups
  adding objects to, 97
  applying graphic styles to, 222
  blending modes, 378
  center point alignment, 102
  collecting, 195
  colors, 399–400
  crop marks for, 438
  deleting, 185
  duplicating, 192
  duplicating objects in, 104–105
  editing, 96
  Live Paint, 240, 245–250
  locking, 193
  merging, 197
  moving, 101
  moving objects in, 104–105
  nested objects within, 380
  opacity, 378
  putting objects into, 96
  removing graphic styles from, 223
  restacking, 191
  selecting and targeting, 202
  selecting objects in, 190
  selecting on Layers panel, 186–187, 190
  targeting, 202, 380
  trim marks for, 438
  ungrouping, 97
  untargeting, 201
  guides, 12, 109–111
Guides & Grid preferences, 30, 84, 414
H
Hand tool, 28, 40, 253
hanging indents, 283
hanging punctuation, 288
Hello screen, 23
hexadecimal colors, 115
hidden characters, 263
HKS colors, 120
HTML files, 452–454
hyphenation, 281, 416–417
I
icons, panel, 38
Illustrator
  files, exporting to Photoshop, 446, 447
  Hello screen, 23
  launching, 1
  opening files from Bridge into, 62
  quitting/ exiting, 14
Illustrator Options dialog, 13, 14
Image Trace panel, 49, 230–234. see also tracings
images
  acquiring, 307–318
  in Art brush, 330
  bitmap, converting into mosaic, 313
  dragging and dropping into Illustrator, 318
  embedded, 308, 315
  linked, 308, 314–317
  locating, 316
  multilayer, 312
  multiple, placing into Illustrator document, 310–311
  in Pattern brush, 337
  Photoshop, importing, 312–313
  placed, viewing data about, 316
  placing by dragging from Bridge, 318
  raster, 229–231
  replacing, 316
  single-layer, 312
  tracing, 229–231
importing into Illustrator
  file formats, 308
  layer comps, 312
  multilayer images, 312
  Photoshop images, 312–313
  settings, 456
  single-layer images, 312
  symbols, 387
  text, 259
  TIFF images, 313
  via Place command, 309
indentation, 283
Info panel, 48, 153
Inner Glow effect, 213
interface brightness, 418
inverting colors, 137
isolation mode
  bar, 98
  exiting, 391
  getting into, 98
  Live Paint groups, 247
  object-level clipping sets and, 373
  putting objects into, 162
J
JPEG format, 448, 451
Justification dialog, 277
K
kerning, 276
keywords (Bridge), 73
Keywords panel (Bridge), 56, 73
Knife tool, 41
Knockout Group option, 381
Kuler panel, 49, 127, 133–135
Kuler themes, 133–135
L
labels, thumbnail (Bridge), 71
Lasso tool, 40, 92, 98
launching Bridge, 4, 56
launching Illustrator, 1
Layer Options dialog, 193
layer-level clipping sets, 372, 374, 376. see also clipping sets
layers
  adding below existing, 183
  adjustment, importing, 312–313
  blending modes, 378
  collecting, 195
  creating, 183–184
  deleted, retrieving, 185
  deleting, 185
deselecting objects in, 188
displaying all, 194
duplicating, 192
flattening, 198
hiding, 194, 347
locking, 193
merging, 197
moving objects to, 192
opacity, 378
pasting to original, 105
Photoshop, importing, 312–313
releasing, 196
removing graphic styles from, 223
renaming, 184
restacking, 191
selecting, 186–187, 188–189
selection area, 188
selection border colors, 183
showing, 194
sublayers, creating, 184
targeting, 202, 380
view, shortcuts for changing, 195
Layers panel
dashed lines, 382
defined, 50
Delete Selection button, 185, 237
Flatten Artwork button, 198
functions, 181–182
illustrated, 50, 181
listings, selecting, 186
Locate Object button, 189
Make/Release Clipping Mask button, 372, 376
menu, 105, 182, 195–197
New Layer button, 183, 192
New Sublayer button, 184
options, 182
restacking via, 191
selecting objects via, 95, 189
selection area, 202
target circle, 188, 201, 202
Layers Panel Options dialog, 182
leading, in type, 275, 412
libraries
applying colors from, 120
brush, 321, 342
closing, 120
cycling through, 120
gradient, 344
graphic style, 221, 228
limiting colors to, 405
swatch, 120, 129
symbol, 386–387, 391
Line Segment tool, 40, 83
linear gradients. see gradients
linked images. see also embedded images
changing status to embedded, 317
editing, 314
embedded images versus, 315
flattener options and, 436
going to, 315
illustrated, 309
managing, 314–317
missing, locating or replacing, 316
Photoshop effects, 315
replacing, 315
scale reduction, 308
transforming, 315
updating, 315
Links panel, 50, 314–317
Live Corners, 78, 92
Live Paint Bucket Options dialog, 241–242
Live Paint Bucket tool, 41, 240–243
Live Paint groups
adding edges and faces to, 247
from blends, 240
created from Blob Brush and Pencil
strokes, 245
creating, 240
expanding, 249–250
fill/stroke attributes, 242
gap options, 248
isolation mode, 247
paths, drawing, 240
releasing, 249–250
reshaping, 246
Live Paint Selection tool, 41, 244
Live Shapes, 78–79
locking layers or objects, 193
M
Macintosh
Application frame, 24
launching Illustrator in, 1
opening Illustrator files from, 55
Magic Wand panel, 50, 99
Magic Wand tool, 40, 92, 99
Manage Workspaces dialog, 36
Marks and Bleed Options (Print dialog), 424–425
masks. see clipping sets; opacity masks
Measure tool, 41
measurement units, changing, 2
merging layers, 197
Mesh tool, 40
metadata (Bridge), 65
Metadata panel (Bridge), 56, 61
Microsoft Office, exporting to, 447
Microsoft Word dialog, 259
missing fonts, 297–298
Missing Profile alert dialog, 63, 309
mosaics, object, 313
moving
anchor points, 158
artboards, 10
Control panel, 43
groups, 101, 104–105
objects, 101
in compound shapes, 359
with drag-copy, 104
to layers, 192
to separate layers, 196
via Clipboard, 105
via Control panel, 153
via Transform panel, 152–153
panel groups, 32, 33
panels, 32
path segments, 158
type between objects, 258
moving (Bridge), 64, 67, 74
N
Navigator panel, 27, 50
New Brush dialog, 340
New Color Group dialog, 127, 237
New Document dialog, 2, 84, 115
New from Template dialog, 4
New View dialog, 31
New Workspace dialog (Bridge), 66
Normal Screen Mode, 29
O
Object menu
Arrange submenu, 192
Artboards submenu, 9
Clipping Mask command, 370, 376
Compound Path submenu, 365, 366, 367
Create Object Mosaic command, 313
Create Trim Marks command, 438
Expand Appearance command, 206, 323, 368, 398
Expand command, 240, 354, 398
Group command, 266
Image Trace submenu, 232
Live Paint submenu, 240, 249
Path submenu
Add Anchor Points command, 162
Clean Up command, 253, 300
Divide Objects Below command, 179
Offset Path command, 106
Outline Stroke command, 364
Pattern submenu, 139, 142
Rasterize command, 216
Shape submenu, 78
Text Wrap submenu, 292
Ungroup command, 97
object-level clipping sets, 370–371, 373, 376. see also clipping sets

objects. see also type objects
adding to clipping sets, 375
adding to compound paths, 366
adding to groups, 97
aligning, 81, 84, 102–103, 107–108
aligning to pixel grid, 108
applying graphic styles to, 222
background, 146
blending modes, changing, 377–379
in clipping sets, 369–376
collecting into new layer, 195
coloring shortcuts, 118
combining, 355–368
with Blob Brush tool, 170
with commands, 177
into compound shapes, 361
into paths, 360
creating guides from, 110
crop marks for, 438
cutting, 179
defined, 182
deleting, 75, 185
deselecting, 100
distributing, 107–108
drawing from center, 76
duplicating, 104–105, 192
ing compound strokes inside, 338
erasing sections of, 173
expanding gradients into, 354
extracting, 357
filling with gradients, 344
flattening selectively, 347
flipping, 151
grouped, editing, 96
hiding, 195
highlighting, 103
isolating, 98, 374
in isolation mode, 162
knocking out, 381
layer, deselecting, 188
locking, 193
mosaics, 313
moving, 101, 104–105, 152–153
moving to layers, 192
moving within compound shapes, 359
in opacity masks, 377–379
painting brush strokes inside, 338
in patterns, 139, 144, 145
putting into groups, 96
quickly creating, 83
rasterizing, 216
reference point, resetting, 151
reflecting, 150–151
releasing guides from, 110
removing from layers, 196
removing from clipping sets, 375
removing graphic styles from, 223
reshaping, 170, 359
restacking, 105, 182, 191, 375
rotating, 81, 82, 147, 150–151, 152–153
rounding corners of, 80
scaling, 147, 150, 152–153
selecting, 75
all, 100
via commands, 94–95
on current artboard, 100
individual, 380
in layer-level clipping set, 374
via Layers panel, 95, 186–187, 188–190
in object-level clipping set, 373
one or more, 93
by path, 93
targeting and, 202
underlying, 93
semitransparent, 434–436
shearing, 152–153
showing, 195
snapping to grid, 112
snapping to point, 109
transforming copy of, 151
trim marks for, 438
type. see type objects
uniting, 357
untargeting, 201
opacity
Bristle brush, 333
fill, 379
glow color, 213
gradient color stops, 349
group, 378
layer, 378
object, changing, 377–379
pattern, 145
replacing setting, 136
shadow, 214
stroke, 379
type, 379
opacity masks, 382–384
Open command, acquiring images with, 308
open paths, 301, 364, 369
Open PDF dialog, 308
OpenType panel, 51, 280
optimizing files for the Web, 448–451
orientation
Art brush strokes, 329
artboard, 10
document, 2
gradient on stroke, 345
in printing, 422
Scatter brush objects, 327
symbols in set, 395
tearoff toolbar, 39
Outline view, 213
output options (Print dialog), 426
Output workspace (Bridge), 59
overflow symbol (type), 253, 259, 260
overprints, 431, 433
P
Package dialog, 440
packaging files, 440–441
Paintbrush tool, 40, 87–88, 163–164
panels, 377–384. see also specific panels
arrangement, with dual displays, 34
closing, 32
floating, 34
icons, 38
maximizing/minimizing, 32
moving, 32
opening, 37, 38
options, showing/hiding, 45
reconfiguring, 32–34
showing and hiding, 32, 38
temporary, opening, 43
values, selecting, 37
panels (Bridge). see also specific panels
configuring, 64
displaying/hiding, 64
moving, 64
PANTONE PLUS colors, 114, 120
Paragraph panel
Adobe Every-line and Single-line Composer options, 281
defined and illustrated, 51
displaying, 282
Hyphenation option, 281
Justification command, 277
Left Indent/Right Indent values, 283
Roman Hanging Punctuation command, 288
Space Before/After Paragraph controls, 283
Paragraph Style Options dialog, 286
paragraph styles, 284–287
creating and applying, 284
defined and illustrated, 284
deleting, 286–287
editing, 285, 286
loading from one document to another, 285
Pattern brushes, 334–337
applied to path, 320
creating, 334–336
editing, 337, 340
image file in, 337
library, 321
Scatter brushes versus, 320
strokes, scaling, 330
Pattern Options panel, 52, 139–142
Pattern Tile Edge Color dialog, 142
patterns
adding background to, 146
applying, 116, 142
creating, 139–143
dimensions, 140
ingredients, 144
editing, 144–145
empty areas, 146
illustrated, 143
number of repeats, 141
object stacking, adjusting, 144
objects used in, 139
opacity of objects in, 145
repositioning, 145
scaling, 140
spacing, 140
tile edge color, 142
tiling configuration, 140
transforming, 151, 153
PDF files, 308, 442–445
Pen tool
adding to open paths with, 163
adjusting anchor points while drawing, 302
converting points on existing path, 304
converting smooth points into corner points, 303
defined, 40
drawing curves with, 301
drawing knife with, 305–306
drawing polygons with, 300
drawing with, 299–302
drawing with Smart Guides and, 302
as temporary Convert Anchor Point tool, 304
Pencil tool
adding to open paths with, 163
creating closed paths with, 86
default settings, restoring, 88
defined, 40
drawing with, 86
functions, 86
Live Paint groups created by, 245
options, 88
reshaping with, 164
perspective, applying, 148
Perspective Grid tool, 40
photos, 134, 135
Photoshop
exporting files to, 454
images, importing into Illustrator, 312–313
layer comps, importing, 312
layer masks, 318
layers, dragging and dropping into Illustrator, 318
layers, importing, 312–313
type, importing, 313
Photoshop effects (in Illustrator), 208, 217–218, 315
pixel grid
aligning objects to, 84, 108
aligning symbols to, 389
viewing onscreen, 84
viewing representation of, 30
Place command, 309–311
Plastic Wrap effect, 218
Plug-ins & Scratch Disks preferences, 417
PNG file format, 447, 448
point type, 252, 262, 263
Polar Grid tool, 41
Polygon tool, 41, 80–81, 83
polygons, 80–81, 300
preferences (Bridge), 61, 65
Preferences dialog, 407–420
accessing, 407
Appearance of Black, 420
File Handling & Clipboard, 314, 419
General, 96, 99, 107, 149, 408–409
Guides & Grid, 30, 84, 414
Hyphenation, 281, 416–417
Plug-ins & Scratch Disks, 417
resetting, 407
Selection & Anchor Display, 79, 93, 101, 157, 411
Slices, 416
Smart Guides, 76, 93, 102, 300, 415–416
Sync Settings, 410
Type, 274, 281, 412
Units, 413
User Interface, 25, 418
presets
Adobe PDF, 437, 442
creating, 437
editing, 437
flattening settings, 436
stroke variable width profile, 166
stroke width profile, 169
tracing, 229–231
transparency flattener, 437
Preview panel (Bridge), 56, 61
Preview view, 30
Preview workspace (Bridge), 59
Print dialog
Advanced options, 431
Color Management options, 430
General options, 422–423
Graphics options, 428–429
Marks and Bleed options, 424–425
Output options, 426–427
Summary options, 431
Print Setup dialog, 44
printable area, 6
printers, 422, 430–431
printing, 422–429
on black-and-white printer, 422
with color management, 430
on color printer, 422
colors for output, 115
crop marks and, 438
oversized artwork, 423
process, 114
semitransparent objects, 434–436
settings, 425, 427
summary settings, 431
trim marks, 438
process colors. see also spot colors appending, 128
changing from nonglobal to global, 136
print output and, 427
shadow, 214
swatches, replacing, 136
tint percentage, changing, 121
values, changing, 136
process printing, 114
profiles, stroke, 166, 169
Proof Setup dialog, 22
proofing, 22, 120
protanopes, 18
PSD files, 309
Pucker tool, 41
punctuation, 278, 288
Q
quotation marks, 278
R
radial gradients. see gradients
raster images. see images
Rasterize dialog, 216
Rasterize Options dialog, 447
rasterizing objects, 216
ratings, thumbnail (Bridge), 71
Rearranging Artboards dialog, 11
Recolor Artwork dialog
Add Color tool, 402
Assign tab, 403
assigning colors via, 403–404
Color Mode menu, 401
Color Reduction Options button, 406
color wheel, 401–402
Colors menu, 405–406
creating color groups via, 399–400
Get Colors from Selected Art button, 401
Harmony Rules menu, 400, 401, 403
illustrated, 400
Link Colors button, 401
New Color Group button, 400, 402
Preset menu, 406
Recolor Art button, 399, 401, 405
reducing colors via, 405–406
Save Changes to Color Group button, 404
Show Brightness and Hue on Wheel button, 402
Show Color Group Storage button, 400
Show Saturation and Hue on Wheel button, 401
Unlink Harmony Colors button, 401
Rectangle tool, 40, 76, 146
rectangles, 76, 77, 253
Rectangular Grid tool, 41
redefining graphic files, 226–227
reference points, 150–152, 389–390
Reflect tool, 41, 150–151, 358
reflecting
with Free Transform tool, 148
with Reflect tool, 150–151
with Transform Each command, 154
registration color, 439
registration point, 387, 389
releasing
clipping sets, 376
compound paths, 367
opacity masks, 384
rendering intents, 22
Reshape tool, 41, 172
reshaping, 157–180
with Blob Brush tool, 170–171
with commands, 176–177
curved segments, 165
curves, 158
Live Paint groups, 246
objects within compound shapes, 359
with Paintbrush tool, 164
path segments, 165
with Pencil tool, 164
with Reshape tool, 172
segments, 158, 165
strokes, 167
tool selection, 162
with Width tool, 167
resolution, 216, 435, 439
reverting, to last saved version, 14
RGB color mode, 2, 17, 115, 119
Rotate tool, 40, 150–151
rotating
with bounding box, 147
direction handles, 160
with Free Transform tool, 148
objects, 82
with Rotate tool, 150–151
Scatter brush objects, 327
with Touch Type tool, 287
with Transform panel, 152–153
type, 264
Rough Pastels effect, 218
Roughen effect, 215
Round Corners dialog, 80
Rounded Rectangle tool, 41, 77, 83
rulers
aligning with left/right margins, 289
guides, creating, 109
showing and hiding, 109
units, changing, 413
S
Save Adobe PDF dialog, 442–445, 450–451
Save Brushes as Library dialog, 342
Save for Web dialog, 449–451
Save Graphic Styles as Library dialog, 228
Save Selection dialog, 100
Save Workspace dialog, 35
saving
color groups, 400, 402
color variations, 132
colors as swatches, 118
dashed strokes as graphic style, 124
embedding color profiles when, 21
file copies, 14
files in AI format, 13
files in earlier versions, 14
gradients, 348
layouts (Bridge), 64
in PDF format, 442–445
print settings, 425
selections, 100
shortcuts, 14
views, 31
workspaces, 35
workspaces (Bridge), 66
Scale dialog, 341
Scale tool, 40, 150–151
scaling
Art brush strokes, 328, 330
artboards, 10
brush strokes, 341
from center, 147
with Control panel, 153
with Free Transform tool, 148
gradients, 351
Pattern brush strokes, 330
patterns, 140
in printing documents, 422
with Scale tool, 150
symbol instances, 266
with Touch Type tool, 287
with Transform Each command, 154
with Transform panel, 152–153
type, 274
Scallop tool, 41
Scatter Brush Options dialog, 326–327, 340
Scatter brushes. see also brushes applied to path, 320
creating, 326–327
editing, 326–327, 340
library, 321
Pattern brushes versus, 320
Scissors tool, 41
screen modes, 29, 40
Scribble effect, 209, 212
Scribble Options dialog, 212
Select menu
All command, 100, 105, 258
All on Active Artboard command, 100
Deselect command, 100
Edit Selection command, 100
Inverse command, 100
Object submenu, 95, 262, 263, 285
Same submenu, 94–95, 205, 381
Save Selection command, 100
selecting
anchor points, 94
clipping paths, 373, 374
crapping sets, 373
via commands, 94–95
with Direct Selection tool, 94
direction handles, 160
layer listings, 186–187
via Layers panel, 95
line segments, 94
masked objects, 373
multiple layer listings, 187
objects, 93, 100, 189
with Selection tool, 93
type, 267–268
type tools, 275
underlying objects, 93
Selection & Anchor Display preferences, 79, 101–103, 109, 158, 411
Selection tool
in adding objects to groups, 96, 97
in adding/subtracting objects, 93
defined, 40
in editing groups, 96
to isolate, 179
in moving objects or groups, 101
in selecting objects, 93
uses, 91
using, 93
selection tools, 91–100
Direct Selection tool, 92, 94
Group Selection tool, 92
Lasso tool, 40, 92, 98
Magic Wand tool, 92, 99
Selection tool, 91, 93, 96–97
selections, working with, 93, 100
Separations Preview panel, 52, 432–433
Shape Builder tool. see also combining objects
defined, 40, 355
dividing objects with, 358
extracting objects with, 357
interlocking shapes illusion with, 358
options, 356
splitting path segments with, 359
uniting objects with, 357
using, 355–359
Shape Builder Tool Options dialog, 356
Shape Mode commands, 359–361
Shape Options dialog, 211
Shear tool, 41, 150–151
shearing
constraining, 151
with Free Transform tool, 148
with Shear tool, 150–151
with Transform panel, 152–153
shortcuts
Bristle brush size and opacity, 333
coloring objects, 118
coloring panels, 114
diameter and intensity change, 393
entering values in panels, 37
paragraph alignment, 282
save dialogs, 14
Transform panel, 153
zooming, 27
Slice Selection tool, 41
Slice tool, 40
Slices preferences, 416
Smart Collections (Bridge), 69
Smart Guides
artboard alignment with, 7
defined, 101
in drawing with Pen tool, 302
information, 103
transformations with, 150
turning on, 77
Smart Guides preferences, 77, 102, 304–305, 415–416
Smart Objects (Photoshop), 454
Smart Punctuation, 278
smooth points. see also anchor points
converting corner points to, 159
converting to corner points, 160, 303
defined and illustrated, 157
direction handles, 157
Smooth tool, 41, 171
spacing type
area type, 254
inset, 255
letter, 277
paragraphs, 283
word, 277
Spiral tool, 41, 84
spirals, creating, 84
spot colors. see also process colors appending, 128
converting to gradient, 427
defining, 219
tint percentage, changing, 121
Squeeze effect, 210
Star tool, 41, 81–82
stars, 81, 82
status bar, 7
stroke colors, 85, 113, 116–117
Stroke panel
Align buttons, 122
Cap buttons, 122–123
Dashed Line settings, 124
defined and illustrated, 53
displaying, 122
Flip Along button, 166
Profile menu, 166
temporary, 122
Weight area, 122
stroke width, 167–169, 212
strokes. see also brush strokes
adding attributes to, 204
adding to characters, 295
alignment, changing, 122
applying, 200
applying gradients to, 345
attributes, applying, 203
attributes, replacing, 136
blending modes, 379
cap/corner style, changing, 122–123
continuous, 85
cap/corner style, changing, 122–123
defined, 85
gradient in, 346–347
opacity, 379
profiles, 166
removing from attribute, 205
variable width profile preset, 166
weight, changing, 85, 122, 200
subkeywords (Bridge), 73
sublayers. see also layers
collecting, 195
defining, 194
deleting, 195
duplicating, 192
locking, 193
merging, 197
options, 184
releasing, 196
selecting on Layers panel, 186–187
Suite Color Settings dialog, 20
Swatch Conflict dialog, 128
Swatch Options dialog, 136
swatches
accessing from library, 120
conflict resolution, 128
creating color groups from, 127
deleting, 129
duplicating, 128, 129
editing, 120, 405
libraries, creating, 129
locating, 120
renaming, 118
restoring, 129
saving colors as, 118
saving gradients as, 350
searching on Swatches panel for, 126
Swatch Libraries menu, 129
Swatches panel
Add Selected Colors option, 118
Add Used Colors option, 118
applying colors via, 116
Color Group button, 127
defined and illustrated, 53
Delete Swatch button, 129
display options, 126
Edit Pattern button, 144, 146
loading gradients onto, 344
New Color Group button, 127, 237
New Swatch button, 129, 348
searching for swatches on, 126
Show Swatch Kinds menu, 126, 129
Swatch Libraries menu, 120, 128, 295, 344
varieties of, 126
views, 126
SWF file format, 447
symbol instances
adding to symbol set, 388
applying Illustrator commands to, 387
creating, 387
deleting from symbol set, 388
duplicating, 387
editing, 391
expanding, 398
placing, 385
registration point, 387, 389
renaming, 390
replacing, 389
unlocking, 397
symbol libraries, 386–387, 391
Symbol Options dialog, 390
Symbol Screener tool, 41, 392–393, 396
Symbol Scruncher tool, 41, 392–394
symbol sets, 387–389, 393, 398
Symbol Shifter tool, 41, 392–394
Symbol Sizer tool, 41, 392–393, 395
Symbol Spinner tool, 41, 392–393, 395
Symbol Sprayer tool, 40, 388
Symbol Stainer tool, 41, 392, 395–396, 398
Symbol Styler tool, 41, 392–393, 397
Symbolism Tools Options dialog, 392
symbols, 385–398
advantages of using, 386
aligning to pixel grid, 389
creating, 390
deleting, from Symbols panel, 390
editing, 391
importing, 387
overflow, 253, 259, 260
predefined, 385
redefining, 391
renaming, 390
replacing, 389
scaling, 266
variations, creating, 391
Symbols panel
Break Link to Symbol button, 397
defined and illustrated, 53
Delete Symbol button, 390
display, changing, 386
New Symbol button, 390
Place Symbol Instance button, 385, 387
Replace Symbol command, 399
Save Symbols command, 391
Symbol Libraries menu, 266, 386, 387, 391
Sync Settings preferences, 410
T
tabs, 288–289
Tabs panel, 54, 289
tearoff toolbars
creating, 39, 159
docking, 39
illustrated, 41
orientation, 39
in saving workspaces, 35
templates, 3–5
text
importing, 259
inserting tabs into, 288
threaded, 260–261
wrapping around objects, 292
Text Import Options dialog, 259
Text Wrap Options dialog, 292
textures, 218
thumbnails
graphic style, 222
opacity mask, 384
symbol, 386
thumbnails (Bridge)
adding to collection, 70
adding to stacks, 67
clicking, 61
colored border around, 60
cycling through, 61
filtering display of, 72
grouping, 67
labeling, 71
moving stacks, 67
nonconsecutive, 60
ratings, 71
rearranging, 67
removing, 67, 70
resizing, 58, 64
selecting, 67
sorting order, 66, 72
stacking, 67
ungrouping, 67
Thumbnails preferences (Bridge), 65
TIFF files, 313, 447
tints, 121, 339
title bar, 6
tool tips (Bridge), 65
tools. see also specific tools
accessing, 39
fly-out menus, 39
hiding, 38
options, 39
pointers, 39
for reshaping paths, 162
selecting, 39
Tools panel, 39–42. see also tools
touch tool, 287
Tracing workspace, 230, 232
tracings. see also Image Trace panel
color settings, 232–234
Control panel options, 231
custom, producing, 232–236
detail control, 235–236
editing, 237–238
expanding, 237–238
faster, 229
presets, 229–231
raster images, 229–231
releasing and restoring, 232
settings, applying, 232–236
tracking, type, 276, 412
Transform Each dialog, 154, 155
Transform Effect dialog, 155
Transform panel, 54, 152–153, 389
transformations, 147–156
with bounding boxes, 147
via dialogs, 152
editing, 155
embedded images, 315
with Free Transform tool, 148–149
pattern, 151, 153
preferences, 149
random values, 154
with Reflect tool, 150–151
repeating, 156
with Rotate tool, 150–151
with Scale tool, 150
with Shear tool, 150–151
Smart Guides and, 150
type, 264
transparency, 377–384
applying, 377–379
exporting, 379
flattener options, 435–436
grid, 381
settings, objects affected by, 380–381
Transparency Flattener Preset Options dialog, 437
Transparency panel
accessing, 377
Blending Mode menu, 201, 378, 379
illustrated, 54, 377
Isolate Blending option, 380
Knockout Group option, 381
Make Mask button, 382
New Opacity Masks Are Clipping command, 382
opacity mask thumbnails, 384
Opacity setting, 378, 379
Release button, 384
temporary, 201, 378
trim marks, 438
TRUMATCH colors, 114, 120
Twirl tool, 41
Twist effect, 207, 215
type
apostrophes, 278
applying appearance attributes to, 294
applying gradients to, 350
area, 254–255, 262–263
blending modes, 379
on a circle, 265–266
converting, 262–263
copying, 258
creating, 252–257, 265
deleting, 252
editing, 38
exporting to Web, 448
 Feather effect, 293
fitting to container, 277
Free Distort effect, 296
horizontal, making vertical, 264
hyphenation, 281
kerning, 276
leading, 275
line breaks, 281
moving, 258
opacity, 379
outlines, 291
overflow, 259, 260
path, 256–257
Photoshop, importing, 313
point, 252, 262–263
quotation marks, 278
recoloring, 119, 252, 271
refining, 266
rotating, 264
scaling, 274
selecting, 119, 267–268
shadow, 293
Smart Punctuation, 278
spacing, 277
styles. see character styles; paragraph styles
styling quickly, 270
text wrap, 292
tools, 251
tracking, 276
transforming, 264
vertical, making horizontal, 264
Type menu
Area Type Options command, 255
Change Case submenu, 271
Convert to Area Type command, 262
Convert to Point Type command, 263
Create Outlines command, 240, 291, 367
Find Font command, 297
Fit Headline command, 277
Show Hidden Characters command, 263
Smart Punctuation command, 278
Threaded Text submenu, 260, 261, 262
Type on a Path submenu, 257
Type Orientation submenu, 264
type objects
coloring, 254
converting, 262
copying, 258, 260
releasing from threads, 261
selecting, 119, 268
threading, to another object, 260
threads, revealing, 261
unthreading, 261
Type on a Path Options dialog, 257
Type on a Path tool, 41, 251–252, 256
Type preferences, 274, 281, 412
Type tool
in copying/moving type, 258
in creating type, 253
default settings, choosing, 269
defined, 40, 251
in entering type inside closed path, 254
font and font size selection, 252
selecting quickly, 275
type illustration, 251
Typekit fonts
activating, 272, 298
defined, 272
illustrated, 273
missing, 298
viewing in Illustrator, 272
working with, 272–273
U
Unembed dialog, 317
uniting shapes, 357, 360, 361
Units preferences, 413
User Interface preferences, 418
V
Vertical Area Type tool, 41, 251–252, 254
Vertical Path Type tool, 41
Vertical Type on a Path tool, 251–252
Vertical Type tool
in copying/moving type, 258
in creating type, 253
defined, 40, 251
in entering type inside closed path, 254
font and font size selection, 252
in placing type on path, 256
selecting quickly, 275
type illustration, 251
View menu
Edit Views command, 31
Guides submenu, 109, 110
Hide Bounding Box command, 101, 103
Hide Edges command, 145, 215
New View command, 31
Outline command, 30
Pixel Preview command, 30, 76, 84
Preview command, 30
Proof Setup submenu, 18, 22
Rulers submenu, 109
Show Grid command, 112
Index

Show Transparency Grid command, 381
Smart Guides command, 76, 93, 94, 102, 237, 267
Snap to Grid command, 112
Snap to Point option, 109
views, document, 30–31

W
Warp tool, 41
Web
colors for, 115
compression, 448
GIF format, 448, 450
image size for, 448
JPEG format, 448, 451
optimizing files for, 448–451
preview settings for, 449
Width Point Edit dialog, 167, 169
Width tool, 40, 167–169, 330
Window menu
Graphite Styles command, 219
Magic Wand command, 99
Manage Tools Panel command, 42
Separations Preview command, 432
Tools submenu, 42
Workspace submenu, 36, 322
Window menu (Bridge), 60
Windows
Application frame, 23
launching Illustrator in, 1
opening Illustrator files from, 55
WMF file format, 446
workspaces
choosing, 34
deleting, 36
duplicating, 36
editing, 35
features of, 23–24
painting, 322
predefined, 35
renaming, 36
resetting, 36
saving, 35
Tracing, 230, 232
workspaces (Bridge)
choosing, 58
deleting, 66
Essentials, 58
Filmstrip, 58, 66
naming, 66
order, changing, 58
Output, 59
Preview, 59
resetting, 66
restoring, 66
saving, 66
thumbnails, 58
Wrinkle tool, 41

Z
Zig Zag effect, 176
zoom levels, changing, 27
Zoom tool, 27, 40